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Dorico 3.5 

18 May 2020 

New features 

Pitch before duration in note input 

When inputting music in Dorico in step time, using either the mouse, computer 
keyboard, or MIDI keyboard, it has always been necessary to choose the duration 
of a note before you specify its pitch. While many users find this very convenient, 
some users prefer to be able to specify the pitch of the note before choosing its 
duration, particularly if they use a MIDI keyboard for input and want to experiment 
with ideas or harmonies before committing to input that material. 

When specifying duration before pitch, provided the caret is visible and note input 
is active, a duration is always specified – it is sticky – which means that any pitch 
you specify by playing a note on your MIDI keyboard or typing its name on your 
computer keyboard is input immediately. If you want to try out melodic ideas 
without inputting them, you therefore have to exit note input each time you want to 
play something without inputting it. 

When specifying pitch before duration, by contrast, when the caret is visible and 
note input is active, a duration is not specified until you either type the number 
corresponding to that duration, or click its button in the notes panel. This means 
that any notes or chords you play on your MIDI keyboard will not be input, and you 
are constantly updating the pitch of the note or chord that will be input when you 
eventually specify a duration: this therefore allows you to try out ideas without 
exiting note input, only committing to input something when you are ready. 

You can freely switch between specifying duration before pitch or pitch before 
duration at any time during note input. In fact, when specifying pitch before 
duration, you will often want to make a particular duration sticky in order to input a 
run of notes all of the same length, and this is done by switching to specifying 
duration before pitch once more, which automatically makes the last chosen 
duration sticky. 

Default note input order. Although you can switch freely between specifying 
duration before pitch or pitch before duration at any time when using Dorico, you 
will probably develop a preference for the default state of note input when you start 
a new project or open an existing one. On the Note Input and Editing page of 
Preferences, the new option By default, specify pitch allows you to specify either 
Before duration (the new method introduced in this release) or After Duration 
(the default method that Dorico has always provided). 
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Immediately below this is another important option concerning selection behaviour 
when specifying pitch before duration, which affects the order in which other 
properties of the note to be input need to be specified. Normally, all properties of 
the note – accidental, articulation, rhythm dot – must be chosen before it is 
committed to the score, whether it is committed by specifying the pitch (in duration 
before pitch) or the duration (in pitch before duration). However, if you would prefer 
to specify the accidental, articulation and rhythm dot after the note has been 
committed to the score, you can do this by setting set Specify accidental, rhythm 
dot and articulations to After inputting note. 

Similarly, if you are using a MIDI keyboard for input, you may find that you want to 
adjust the enharmonic spelling of the note that you have just input, in which case it 
is important that the note you have just input remains selected so that you can 
change its spelling with Alt+-/=, so you may find After inputting note the more 
useful setting when inputting using the MIDI keyboard. 

If, on the other hand, you are using the computer keyboard and not a MIDI 
keyboard, you may find it more helpful for the note you have just input not to be 
selected, so that you can instead use Alt+↑/↓ to manipulate the shadow 
notehead to specify the pitch of the next note. If this seems most useful to you, 
choose Before inputting note. 

Do take notice that Specify accidental, rhythm dot and articulations takes effect 
regardless of whether you are using the new pitch before duration input method, or 
Dorico’s original duration before pitch method. You may want to try out both 
approaches to see what feels most natural to you. 

Toggling between input orders. To toggle between pitch before duration 
or duration before pitch at any time during input, simply type K, or click 
the note input toolbox button shown on the right. 

Mouse input and pitch before duration. When pitch before duration input is active, 
you can use the mouse to position the shadow note, then either click the duration 
of the note you want to input in the Notes panel or type its shortcut. If you prefer 
not to use mouse input, activate the Select tool (the arrow at the top of the note 
input toolbox). 

Specifying pitch. When pitch before duration input is active, no note or chord will 
be input until you choose the duration for the note to be input, but there is no 
requirement for the note or chord to be held down when you choose the duration. 
You can specify the pitch or pitches, and if you are using a MIDI keyboard, you can 
release all of the keys before you choose a duration: the shadow noteheads will 
show the pitch or pitches that will be input. Each time you play a new note or 
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chord, or each time you type a new pitch name on the computer keyboard, you 
update the pitch of the pending note or chord. 

If you are using the computer keyboard, type the note name to show the shadow 
note. To specify the same pitch in a higher octave, hold Shift+Alt and type the 
note name again; repeat this to transpose upwards by a further octave. To specify 
a lower octave, hold Ctrl+Alt (Windows) or Control (Mac) and type the note name; 
repeat to transpose downwards by a further octave. Once the shadow note is 
shown, and provided the option When specifying pitch before duration is set to 
Do Not Select Input Notes, you can also transpose the shadow note by step 
using Alt+↑/↓. 

To specify an accidental when using the computer keyboard, first type the note 
name, then type the key command for the desired accidental (by default, 0 for 
natural, - for flat, = for sharp). 

Building chords. When using a MIDI keyboard, you can simply play all of the notes 
of the chord together before you choose the duration. When using the computer 
keyboard, engage chord input by typing Q. The familiar + sign appears to the left of 
the caret. Now as you type each note name on the keyboard, a new shadow note is 
added at the caret position; just as when inputting duration before pitch, build the 
chord from the bottom up, and when you have specified all of the pitches, choose 
the duration to input the chord. 

Choosing duration. Once you have primed the pitch or pitches of the note or chord 
to be input, choose the duration by typing the appropriate key command. If you 
require a dotted note, type . or click the dotted note tool in the note input toolbox 
before you type the key command for the chosen duration. 

Inputting a run of notes of identical duration. If you want to input a run of, say, 
eighth notes, you can continue to type 5 repeatedly after specifying each pitch, or 
you can instead return temporarily to specifying duration before pitch by typing K, 
which will cause the last chosen duration to become sticky. At the end of the run of 
notes, type K again to return to pitch before duration. 

Inputting tuplets. When inputting duration before pitch, you choose the unit of the 
tuplet before invoking the tuplet popover, and the tuplet is created as soon as you 
confirm the popover. When inputting pitch before duration, you have two options: 
specify the unit of the tuplet in the popover; or allow Dorico to infer the unit of the 
tuplet from the first note you input after confirming the popover. 

To specify the unit of the tuplet in the popover, add the letter that corresponds to 
the desired duration after the second number in the ratio: 

§ Whole note (semibreve): w 
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§ Half note (minim): h 
§ Quarter note (crotchet): q 
§ Eighth note (quaver): e 
§ 16th note (semiquaver): x 
§ 32nd note (demisemiquaver): y 
§ 64th note (hemidemisemiquaver): z 

So, for example, to specify a quintuplet of eighth notes in the time of a quarter note, 
enter 5:2e into the popover. 

To allow Dorico to infer the unit instead, simply type the ratio as normal into the 
tuplet popover: when the popover is confirmed, no tuplet will be created until you 
next commit a note, at which point the tuplet will also be confirmed, taking its unit 
from the duration of the note you input. 

Rest input. To input a rest, type , (comma) to engage rest input, then simply type 
the duration of the rest to be input; a shadow rest appears on the caret. There is no 
need to specify a pitch. To leave rest input, simply type or play a pitch, and the 
shadow note will reappear. 

Lock Duration. Lock Duration behaves the same way regardless of the input order 
you are currently using: simply type or play the note, and the caret automatically 
advances to the next note, retaining the durations of the notes or chords at each 
position. When you either type L to disengage Lock Duration or reach the end of 
the existing music, pitch before duration input resumes automatically. 

Expression maps 

Dorico 3.5 brings a suite of improvements to its capabilities in working with today’s 
sophisticated virtual instruments and sample libraries. We have surveyed a number 
of the latest libraries from the top manufacturers to understand the kinds of 
techniques their developers have used in designing their products, and introduced 
features to make it easier to set up expression maps that work with the design of 
these libraries, rather than against them. 

It is important to understand that with today’s powerful and comprehensive sample 
libraries, it is on the whole impractical for either Steinberg or the library 
manufacturer to create and distribute a single expression map, or even a single set 
of expression maps, that will provide a plug-and-play solution to make playback 
sound great with no effort from you. Today’s sample libraries are so enormously 
detailed and resource intensive that it is unlikely you will be able to load every 
sound in a plug-and-play template for a whole orchestra on a typical computer, so 
it is necessary for you to be more selective about which instruments – and even 
which playing techniques and articulations for a certain instrument – you will load. 
And while the general mechanical processes used by sample library developers to 
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make it possible to choose between the different articulations, techniques, layers, 
microphone positions and so on are broadly the same, using a combination of key 
switch notes and MIDI controllers, the details of how these processes are 
implemented are different for every library – very often even for libraries from the 
same manufacturer. 

But do not be disheartened: while this means that you will have to engage with the 
details of how your chosen sample library works, and you will have to spend some 
time working with expression maps in Dorico, this modest effort will pay off quickly. 

Our primary goal with the improvements in Dorico 3.5 is to make it easier and 
quicker for you to create and edit expression maps, and to that end there are not 
only new capabilities – including automatic switching of articulation based on 
played note length, add-on switches that can dramatically reduce the number of 
technique combinations you need to define, and so on – but also usability 
improvements in Play ▶ Expression Maps to make the process more pleasant. 

Switch types. Switches in expression maps can now be one of three types: 

§ Base: this is the type of switch that existed in previous versions of Dorico, 
and to which all switches in existing expression maps created in earlier 
versions will be mapped when you open your existing projects in Dorico 
3.5. A base switch will typically describe a significant change in playing 
technique or articulation, such as pizzicato versus arco, or staccato versus 
legato. Base switches are by their nature mutually exclusive, so switching 
from one base switch to another removes the prevailing playing technique 
and switches to the new one. 

§ Add-on: this new switch type can be useful for defining playing techniques 
or articulations that can be added to an existing base switch; for example, 
some libraries use a consistent set of MIDI controllers to control legato, and 
this applies regardless of what base sound is currently in use. An add-on 
switch does not remove or change a base switch. Add-on switches are 
simpler than base switches and can only trigger simple key switch notes 
and controller values. 

§ Init: this new switch type can be used to send a particular set of 
instructions when playback starts; for example, you might want to reset a 
round-robin controller, or ensure a particular MIDI controller always starts at 
a particular known value. Every expression map defines an init switch, but it 
will be empty by default. Like add-on switches, the init switch can only 
trigger simple key switch notes and controller values. 

Conditions. Base switches can now define conditions that must be satisfied in 
order for them to be triggered. In this release, note length is the only conditional 
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value supported, but we plan to expand support for conditions in future versions, 
allowing you to create simple sets of conditions using Boolean logic. For an 
example of conditions in action, look at the default HSO Violin Solo expression 
map, which defines two switches for the Natural playback playing technique, and 
two switches for Legato, with each of the two switches conditional on note lengths 
being longer or shorter than the Medium length. 

Note length can be one of five values: 

§ Very short: dotted 16th at 120bpm (0.1875 seconds) 
§ Short: dotted eighth at 120bpm (0.375 seconds) 
§ Medium: dotted quarter at 120bpm (0.75 seconds) 
§ Long: dotted minim at 120bpm (1.5 seconds) 
§ Very long: any longer duration 

This choice of note lengths allows you to easily switch between different lengths of 
samples that are provided, for example to switch between staccatissimo, staccato, 
marcato and short sounds, and can really enliven the interpretation of a phrase. 

Enabling and disabling switches. It is now possible to disable a switch in your 
expression map without removing it, which can be useful when experimenting with 
a particular approach to handling a particular playing technique, or if you are 
working with an expression map that defines a greater number of playing 
techniques than you can load or require for your current project. Simply select the 
switch from the table in the Base and Add-on Switches section and deactivate 
the Enabled checkbox on the right-hand side. 

Descriptive names for switches. Switches can now have a descriptive name, 
instead of simply listing the combination of playback playing techniques they 
handle. This allows you to match the name of a switch to the terminology used in 
the sample library, if you would find that useful: simply select the switch from the 
table in the Base and Add-on Switches section and then edit the Name field. To 
see which playback playing techniques are handled by a switch with a custom 
name, simply hover over the entry in the list, and the tool tip will show you. 

Reordering actions. It is normally crucial that a series of MIDI messages intended 
to trigger a particular playing technique in the sample library is received in the 
correct order, so you can now change the order in which the actions for a switch 
are output. In the action bar for the Actions table in the Base and Add-on 
Switches section you will find upward and downward pointing arrows, which allow 
you to re-order the switches. 

Duplicating actions. You can now duplicate an entry in the Actions table by 
clicking the new Duplicate Action button in the action bar. 
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Automatic mutual exclusion groups. Mutual exclusion groups define the 
relationships between playback playing techniques and how they can be combined 
or otherwise in the particular sample library you are using. If two playback playing 
techniques are defined as being mutually exclusive with each other, then if playing 
technique A is active and a notated item that gives rise to playing technique B is 
encountered, then playing technique A is removed and playing technique B is 
added. If these techniques were not mutually exclusive, B would be added to A, 
and the expression map would be expected to define a set of actions to produce 
the combination A+B. 

Although you are still free to define your own mutual exclusion groups in Dorico 
3.5, the program can now define mutual exclusion groups automatically for you, 
and indeed does so by default in any expression maps you create. 

If you want to create your own mutual exclusion groups, expand the Mutual 
Exclusion Groups section of the Expression Maps dialog, and deactivate the 
Auto checkbox. Beware that if you later decide to re-enable automatic mutual 
exclusion groups, when you reactivate the Auto checkbox, any manual mutual 
exclusion groups you have created will be removed. 

Combined dynamics. The combined dynamics ,  and  can now give rise 
to playback playing techniques if needed, allowing you to trigger dedicated 
samples for these dynamics if your library provides them. 

Importing expression maps. You can now import either Dorico or Cubase 
expression maps by dragging and dropping the files onto the Expression Maps 
dialog. 

Importing Cubase expression maps. You can now import several Cubase 
expression maps at once, and Dorico imports a wider variety of switches from 
Cubase expression maps than in previous versions, mapping them on to the 
appropriate playback playing technique in Dorico (including Bartòk pizzicato, snap 
pizzicato, harmonics, con sord./senza sord., flautando, flutter-tongue, and others). 
However, you should still consider an imported Cubase expression map only a 
starting point for developing your own native Dorico expression map, as the two 
applications approach the handling of sample libraries in a rather different way. 

Line style editors O 

Building on the flexible and powerful horizontal, note-attached and vertical lines 
introduced in Dorico 3.1, Dorico 3.5 now makes it possible for you to extensively 
customize these lines and design your own new ones, thanks to a set of four new 
editors available from the Engrave menu. 



 

 
Dorico 3.5 Version History Page 10 Steinberg Media Technologies GmbH 

In order to understand how the four editors are used, it’s worth dwelling for a 
moment on the anatomy of Dorico’s lines. A line is made up of the following 
ingredients: 

§ The main part of the line is the line body. This can be one of three kinds: a 
generic straight line of a particular thickness, dot or dash pattern, or a 
double line; a wedge, which goes from thick-to-thin or thin-to-thick over its 
length; or one made up of multiple repeatable symbols. 

§ The start and end of the line can each optionally show a cap. The cap can 
be an arrowhead, a hook, a terminal line (a line that extends an equal 
distance to either side of the body), an item of text, or a music symbol. 

§ The middle of the line can optionally show an annotation, or show 
hyphenated text over the length of the line body. The annotation can be an 
item of text or a music symbol. 

There are separate editors for line bodies, line annotations (which are used both as 
start and end caps, and as annotations in the middle of the line body), and 
repeatable symbols (which are used as raw materials for line bodies). These 
ingredients are combined together in Engrave ▶ Lines, so we will begin there. 

Lines editor. You can open the lines editor in one of the following ways: 

§ Click the edit button in the action bar at the bottom of either section of the 
Lines panel in Write mode; or 

§ Select a line in the music in Engrave mode and type Return; or 
§ Double-click a line in Engrave mode; or 
§ Choose Engrave ▶ Lines. 

The Edit Lines dialog appears: 

 



 

 
Dorico 3.5 Version History Page 11 Steinberg Media Technologies GmbH 

On the left-hand side, you can choose to edit either Horizontal or Vertical lines. 
Select the line you want to edit, or use the buttons in the action bar at the bottom 
of the list to create a wholly new line, or a new line based on the currently selected 
line. The panel on the right-hand side of the dialog will look different depending on 
whether you are editing a horizontal or vertical line; when editing a vertical line, the 
preview runs up the right-hand side of the dialog, the better to show how it will 
look in the score itself. 

The options on the left-hand side of the panel are as follows: 

§ Body style: this lists the line bodies, as defined in Engrave ▶ Line Bodies. 
Below this selector is a link that jumps to the Line Bodies dialog, in case 
you want to edit or create a line body. 

§ Start cap / End cap: these selectors list all of the line annotations that can 
be used as caps, as defined in Engrave ▶ Line Annotations. 

§ Continuation cap: this is the line annotation that will be used at the start of 
any segment of the line after the first (which uses the Start cap), if the line 
continues across a system break, and only applies to horizontal lines. To 
see a preview of how this cap will appear, ensure Show Crossing Break is 
activated below the preview, which will show the line in two segments. 

§ Continuation end cap: this is the line annotation that will be used at the 
end of each segment of the line except for the last (which uses the End 
cap), if the line continues across a system break, and only applies to 
horizontal lines. Below is a link that jumps to the Line Annotations dialog, 
in case you want to edit or create an annotation. 

§ Distance from staff line: when the line is positioned outside the staff, this 
defines the minimum distance that Dorico must maintain between the 
outermost staff line and the line. If this value is not set, the value for Default 
distance from staff on the Lines page of Engraving Options will be used 
instead. 

§ Distance from item: when an item protrudes outside the staff, this defines 
the minimum distance that Dorico must maintain between the protruding 
item and the line. Dorico will always use the larger of the Distance from 
staff line or Distance from item values as appropriate. If this value is not 
set, the value for Minimum distance from protruding items on the Lines 
page of Engraving Options will be used instead. 

§ Hooks follow line pattern: for lines that are set to use a hook or terminal 
line for any of its caps, activating this option will cause Dorico to use the 
same line pattern as the line body for the hook or terminal line, if possible. 
So if, for example, you have a dotted line body, or a line body that uses a 
pattern of alternating long and short dashes, provided the hook or terminal 
line is sufficiently long to fit the line body pattern into its length, Dorico will 
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draw the hook or terminal line in the same style as the line body; otherwise, 
the hook or terminal line will be drawn using the line type defined for the 
line annotation. If the dot or dash pattern has multiple pairs of values, the 
hook or terminal line will draw only using the first pair of values. 

§ Whole body on each system: if a line crosses one or more system breaks, 
this option determines whether or not each segment of the line should 
contain the complete line body, or whether the line body should be split 
proportionally between the total number of segments. This is easiest to see 
in the case of lines using wedge bodies: when Whole body on each 
system is activated, each segment will show the complete wedge from 
thin-to-thick or thick-to-thin; when it is not activated, each segment will 
show only a portion of the overall wedge. Similarly, if the line uses a Center 
Annotation or Hyphenated Text, Whole body on each system 
determines whether the entire annotation should be repeated in each 
segment, or should be divided between all segments. 

The options on the right-hand side of the panel change, depending on the choice 
made under Annotation, which allows you to add a further annotation to the line. 

If you choose Center Annotation, this allows you to show a text or music symbol 
annotation in the middle of the line, with the following options: 

§ Annotation: this selector lists all of the compatible line annotations. By 
default in a newly-created project there will be none listed here, because 
there are no text or music symbol line annotations in Dorico’s factory library. 
Define suitable line annotations in Engrave ▶ Line Annotations and they 
will appear here. 

§ Vertical position: this selector specifies the position of the line annotation 
relative to the line, allowing you to choose between the annotation being 
centered on the line, or positioned above or below the line. 

§ Repeat: allows you to specify whether the annotation should appear just 
once in the middle of the line, or whether it should be repeated multiple 
times along the length of the line. If you choose to repeat the annotation, it 
can be repeated at regular intervals (Equidistant), or with larger intervals at 
the start of the line and smaller intervals at the end of the line 
(Accelerating), or the converse, smaller intervals at the start of the line and 
larger intervals at the end of the line (Decelerating). When Equidistant is 
chosen, Repeat distance specifies the distance in spaces between 
repetitions of the annotation. 

§ Placement: specifies whether the annotation should appear in the Center 
of the line (the default), or at the Start or End. If the annotation is shown at 
the start or end of the line, the annotation will be inset from the start or end 
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by the value of Start/end gap. If Start/end gap is set to 0, and the line 
starts or ends with a cap, be aware that the annotation will overprint the 
cap at that end of the line. 

§ Always horizontal: this specifies whether or not the line annotation should 
be allowed to rotate when the line is rotated. 

If you choose Hyphenated Text, this allows you to show a series of syllables (such 
as “slen-tan-do-po-co-a-po-co”) over the length of the line, with the following 
options: 

§ Syllables: enter the text that you want to appear along the length of the line 
here; be sure to separate each syllable with a hyphen. 

§ Font style: specifies the font style, defined in Engrave ▶ Font Styles, to 
use for the hyphenated text. 

§ Starts with text: when activated, this means the first syllable will appear at 
the start of the line, instead of whatever is defined as the Start cap. When 
not activated, the first syllable will appear some distance after the start of 
the line. 

§ Ends with text: when activated, this means the final syllable will appear at 
the end of the line, instead of whatever is defined as the End cap. When 
not activated, the final syllable will appear some distance before the end of 
the line. 

§ Gap on the left / Gap on the right: these values define how much white 
space should be left between the line body and the syllable at each 
occurrence. 

§ Position: defines the vertical position of the text relative to the line body. 

You can save any line you define as a default for new projects you create in future 
by clicking the star icon (  ) in the action bar at the bottom of the list of lines on 
the left-hand side of the dialog. If you edit one of the factory line types and want to 
return it to its factory state, click the revert icon (  ). 

Line bodies editor. Choose Engrave ▶ Line Bodies to open the line bodies editor: 
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Using the Category selector in the top-left corner, you can choose between the 
three types of line bodies you can design. We will take each of them in turn. 

For Generic, the following options are available: 

§ Style: determines whether the line will be Solid, which produces a single 
solid line; Double line, which produces two parallel solid lines; or Dashed 
or dotted, which produces a single line with a variable pattern of dashes or 
dots. 

§ Line width: specifies the width, in spaces, of the line. 
§ Dash-gap pattern: specifies a series of pairs of values that describe the 

pattern of dashes or dots and gaps to be used for the line. There must 
always be an even number of values here: the first value describes the dash 
length or dot diameter, and the second value describes the following gap. 
Each value must be separated from its neighbour with a semicolon. You 
can specify the length either as a fraction (for example, 1/2 or 1 3/4) or a 
floating-point decimal value (for example, 0.5 or 1.75). To specify the length 
dash, use a positive value; to specify the diameter of a dot, use a negative 
value. For example, the values 1/2; 1/2; -1/2; 1/2 produces a series of 
alternating dashes and dots, separated by gaps of half a space. 

§ Line separation: specifies the distance in spaces between the two parallel 
lines when Style is set to Double line. 
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For Repeatable Symbols, things work a little differently. The preview at the top of 
the panel shows how the various settings below combine. 

Below that is a single-row grid showing which symbols are used to produce the 
line body. If the line begins or ends with a specific symbol, those symbols will be 
annotated with S for start and E for end. Activate Show Repeat Point to show a 
vertical line on each item showing the point at which the next symbol will be drawn. 
To remove a symbol from the grid, either select it and click the delete icon at the 
right-hand side of the action bar, or simply double-click it in the grid. 

To add a new symbol to the grid, use the multi-row grid below. If you double-click a 
symbol in the multi-row grid, it will be added to the grid above as a regular symbol 
that can appear anywhere in the line body. To add a specific symbol for the start of 
the line body, select it and click Add to Start. Similarly, to add a specific symbol for 
the end of the line body, select it and click Add to End. The symbols that appear in 
this multi-row grid are defined in Engrave ▶ Repeatable Symbols, which is 
described below. 

Finally, the Repetition selector between the two grids allows you to specify how 
the symbols should be repeated along the length of the line body: 

§ Individual symbols: this divides the symbols between the whole length of 
the line body. If you had three symbols in the line body, for example, Dorico 
will repeat the first symbol for the first third of the line body, the second 
symbol for the middle third, and the third symbol for the final third. 

§ Whole pattern: this repeats the entire pattern along the whole length of the 
line body, cycling through each symbol once, then repeating the whole 
pattern again. 

When line crosses system break, add ends to each segment specifies whether 
each segment of the line should start and end with the symbols given those special 
roles. 

For Wedge, the following options are available: 

§ Wedge type: determines the shape of the wedge to be used. Flat outside 
produces a wedge that will have a flat top when placed above the staff, or 
a flat bottom when placed below the staff; Flat inside the converse. 
Symmetrical produces a wedge that proceeds from its maximum thickness 
to its minimum thickness equally above and below. 

§ Start thickness: specifies the width, in spaces, of the left-hand end of the 
wedge. 

§ End thickness: specifies the width, in spaces, of the right-hand end of the 
wedge. 
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Line annotations editor. Choose Engrave ▶ Line Annotations to open the line 
annotations editor: 

 

Using the Category selector in the top-left corner, you can choose between the 
various types of line annotations you can create in the dialog. We will take each of 
them in turn. 

For Arrowhead, the following options are available: 

§ Arrow style: specifies whether the arrowhead will be a pair of angled lines 
(Chevron), or an outline (Empty triangle) or solid (Filled triangle) 
arrowhead. 

§ Width: defines the width of the arrowhead, in spaces. 
§ Height: defines the height of the arrowhead, in spaces. 
§ Line width: defines the width of the line to be used to draw the arrowhead, 

in spaces. 

For Hook, the following options are available: 

§ Length: defines the length of the hook, in spaces. 
§ Line width: defines the width of the line to be used for the hook, in spaces. 
§ Direction: defines the direction in which the hook should point. For hooks 

intended for use with horizontal lines, the most useful values are probably 
Inward, which means that it will point towards the staff whether it is placed 
above or below the staff, and Outward, which means it will point away from 
the staff, but you can also force the hook to always point Up or Down. For 
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hooks intended for use with vertical lines, the only values that are likely to 
be useful are Right and Left. 

§ Rotation: specifies whether the hook should follow the rotation of the line 
(Rotated), or whether it should always point to one of the four cardinal 
directions (Aligned with axis). 

For Music Symbol, the following options are available: 

§ Symbol: click Edit to open the symbol editor, in which you can choose one 
or more glyphs from a font, add text, or import a graphic. Once you have 
edited the symbol and click OK to confirm the symbol editor, the chosen 
symbol will appear in the previews at the top of the panel. 

§ Horizontal attachment: defines the attachment point of the symbol relative 
to a vertical line. 

§ Vertical attachment: defines the attachment point of the symbol relative to 
the horizontal line. 

§ Gap above / Gap below / Gap on the left / Gap on the right: define the 
gap between the symbol and the line body, in spaces. 

§ Rotation: specifies whether the symbol should follow the rotation of the 
line (Rotated), or whether it should always point to one of the four cardinal 
directions (Aligned with axis). 

For Terminal Line, the following options are available: 

§ Length: defines the length of the terminal line, in spaces. 
§ Line width: defines the width of the line to be used for the terminal line, in 

spaces. 
§ Rotation: specifies whether the terminal line should follow the rotation of 

the line (Rotated), or whether it should always point to one of the four 
cardinal directions (Aligned with axis). 

For Text, the following options are available: 

§ Text: defines the actual text that should appear on the line. 
§ Font style: specifies the font style, defined in Engrave ▶ Font Styles, to 

use for the text. 
§ Horizontal attachment: defines the attachment point of the text relative to 

a vertical line. 
§ Vertical attachment: defines the attachment point of the text relative to the 

horizontal line. 
§ Gap above / Gap below / Gap on the left / Gap on the right: define the 

gap between the text and the line body, in spaces. 
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§ Rotation: specifies whether the text should follow the rotation of the line 
(Rotated), or whether it should always point to one of the four cardinal 
directions (Aligned with axis). 

§ Erase background: specifies whether an area around the text should be 
erased; activate this if you plan to use the line within the staff, as this will 
cause the staff lines and barlines to be knocked out around the text. 

§ Ignore font metrics determines whether Dorico should position the text 
according to its tight bounding rectangle, rather than using the font’s 
normal metrics for ascenders and descenders; this also affects the size of 
the background erasure if Erase background is active. 

Repeatable symbols editor. Choose Engrave ▶ Repeatable Symbols to open this 
dialog: 

 

This allows you to define your own repeatable symbols that can be used in line 
bodies. The options are as follows: 

§ Symbol: click Edit to open the symbol editor, in which you can choose one 
or more glyphs from a font, add text, or import a graphic. Once you have 
edited the symbol and click OK to confirm the symbol editor, the chosen 
symbol will appear in the previews at the top of the panel. 

§ Repeat offset: this determines the point, in spaces, from the left-hand side 
of the symbol at which the next symbol in the sequence should begin. A 
value of zero means the left-hand side of the symbol with maximum overlap. 

The preview at the top of the panel provides a couple of tools to help you achieve 
the correct tessellation. Show Multiple draws the symbol multiple times, one after 
the other, with the next symbol starting at the position defined by Repeat offset. 
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Show Repeat Point draws a vertical line in orange at the position defined by 
Repeat offset. 

If you want to see how one particular symbol tessellates with other symbols, use 
Engrave ▶ Line Bodies to define a line body that uses several different repeatable 
symbols. 

Figured bass 

Figured bass is a musical shorthand commonly used in European music notation 
throughout the 17th and 18th centuries. Figures (numerals) are used to describe 
the changing harmony of the music, with each figure describing the interval above 
the written bass note. 

 

Figured bass was typically played on accompanying instruments such as 
keyboards and fretted instruments, and meant both that the composer could 
communicate the intended harmony efficiently and that the performer was given 
considerable creative leeway in the interpretation of the figures through 
improvisational performance. 

Dorico 3.5 introduces a new popover for the input of figured bass and provides 
comprehensive options for its appearance in your score, together with some 
unique capabilities arising from its semantic understanding of what the figures 
themselves actually mean. 

The way Dorico approaches figured bass is intended to address two distinct types 
of usage: firstly, to make it possible to reproduce existing editions closely, with the 
ability to specify exactly how and where figures should appear at the time of input; 
and secondly, to provide a more flexible approach that allows Dorico more freedom 
to respond to changes to the music more intelligently, and which affords you more 
options for deciding how overall the figures should be presented using the 
provided engraving options. 

This is conceptually similar to working with the Force Duration feature for note 
input switched on or switched off. When Force Duration is switched on, you can 
specify exactly how each note, chord and rest should be notated, but when you 
make large structural changes to the music, like changing meter or inserting or 
removing music, Dorico has less freedom in how it can rewrite the affected music 
to make sense of the changes. When Force Duration is switched off, by contrast, 
you allow Dorico’s notation options to determine key aspects of the notation, such 
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as how notes are split into ties and how rests are grouped, which both allows you 
to input music more quickly and also gives you greater future flexibility in making 
large structural changes to the music, since Dorico is free to rewrite the music to fit 
the new structure. 

It is therefore quite important that you make this choice at the outset of your 
project.  

Input options. The most important input option is found on the new Figured Bass 
page of Write ▶ Note Input Options. If you need to reproduce an existing edition 
exactly, or you are very particular about exactly how you expect figured bass to 
appear, set When inputting via the popover to Follow input literally. If, on the 
other hand, you do not know at the outset exactly how you want your figures to 
appear or expect to be making substantial revisions to the music over the course of 
the project, choose Follow Engraving Options. 

This option affects figured bass at the time it is input: changing this option has no 
retrospective effect on figured bass you have already input in your project. You can, 
however, later reset existing figured bass if you need to – see below. 

Figured bass popover. To input figured bass, show the caret on the staff 
where you want to start inputting, or select a note on that staff, then 
either type Shift+G or click the button shown to the right, which is found in the 
notations toolbox on the right-hand side of the window in Write mode. The popover 
appears at the caret or selection position, allowing you to input figures. 

§ You can input figures from 1 to 9 in the popover, in any order: Dorico will 
rearrange the figures into ascending order automatically. 

§ To specify accidentals, type # for sharp, b for flat, and n for natural. Dorico 
can usually determine by context whether the accidental should apply to 
the preceding or following figure, but to remove any ambiguity, you can 
separate each figure with accidental from the next with commas; for 
example, 6,#4,2. 

§ To input a raised third, you can type # on its own. 
§ Dorico will infer figures beyond those you type, so to input common figures 

you can input only one or two figures, allowing Dorico to fill in the gaps. For 
example, to input a first inversion triad (6 over 3), you can simply type 6. 

§ To specify that a particular figure should be hidden, enclose it in angle 
brackets, e.g. 6<3> will tell Dorico to show the 6 but hide the 3. 

§ To specify a suspension with resolution, type for example 4->3, which 
describes a fourth resolving to a third. 
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You can also use the same input syntax as you would use in the Shift+Q popover 
for inputting chord symbols, so you can type things like Em7 or G/B, and Dorico 
will convert these chord symbols into the correct figures. 

Advancing the popover. The figured bass popover can be advanced with the 
following keys: 

§ Space advances to the next beat, or the next note, whichever comes 
sooner. 

§ ←/→ advances to the previous or next rhythmic grid position. 
§ Tab/Shift-Tab advances to the start of the next or previous bar. 

Specifying where figured bass appears. Dorico will automatically make figured 
bass appear on any instrument on which you invoke the Shift+G popover. You can 
further choose which instruments should show figured bass via the Players to 
show figured bass option in the new Figured Bass section of the Players page 
of Layout Options. Here you will also find an option that determines whether 
figured bass should appear below the staff (the default) or above. 

Local figured bass. By default, figured bass is specified globally; that is to say, it is 
assumed that the same figures apply to all the instruments in the ensemble. If you 
need to show different figures on different instruments, this can be done by 
creating local figured bass. While the popover is open, hold Alt to temporarily 
specify that the current figure should be created for the current instrument only; to 
input a run of local figured bass, type Alt+L to lock the popover to local input, and 
to return to global input, type Alt+G. 

Figures are relative to the bass note. When you input figured bass, Dorico 
calculates the absolute pitches of the notes corresponding to the figures you have 
entered relative to the bass note at the position of the popover, and stores these. 
This allows Dorico to recalculate the figures in the event that you change the pitch 
of the bass note: for example, if you change the inversion by moving the bass note, 
the figures will be rewritten to reflect the new inversion. This also means that if you 
have global figures shown on instruments with differing bass notes, different 
figures will appear on each instrument. 

Transposing figured bass. When you transpose music that includes figured bass, 
Dorico will transpose the figures along with the music, including replacing sharps 
with flats or flats with sharps as necessary. 

Hold lines. When the bass note changes but the notes in the chord above it are 
held, a hold line is drawn proceeding from the figures for the rhythmic duration for 
which the figures should continue to apply. To add a hold line, select the figures 
and type Shift+Alt+→ to make a hold line appear; type Shift+Alt+→ again to 
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extend the hold line by the current rhythmic grid value, or click and drag the circular 
handle to extend or retract the hold line. 

Alternatively, you can activate the Duration property in the Figured Bass group in 
the Properties panel. The property allows you to specify the duration of the hold 
line as a rhythmic duration: the left-hand value is the number of quarter note 
(crotchet) beats, while the right-hand value allows you to specify that the hold lines 
should end at a grace note position if necessary. 

Suspensions. When you specify a suspension, for example by typing 4->3, the 
resolution figure is created immediately to the right of the suspension figure. You 
can click and drag the circular handle that appears on the resolution figure to 
adjust its position, or alternatively you can activate the Resolution pos. property to 
specify its rhythmic position. 

Choice of figures. The Figures section of the Figured Bass page of Engraving 
Options provides options that determine how Dorico handles all of the common 
combinations of figures, including triads in root position and inversions, how raised 
thirds should appear, and so on. These options will be followed if When inputting 
via the popover is set to Follow Engraving Options in Note input Options; if, on 
the other hand, you have input the figures with Follow input literally, Dorico will 
reproduce exactly the figures you have input. 

Diminished intervals. There are different conventions in use for whether or not it is 
considered necessary to show figures when they form a diminished interval, either 
with a lower figure or with the bass note. For example, in the key of C major, if you 
had a bass note of B and a raised third, often the fifth would not be given an 
explicit figure; by convention, because diminished fifths are rare in the music of this 
period, the fifth would nevertheless also be raised, to avoid forming a diminished 
interval with the bass note. 

You can choose how Dorico should handle situations like this using the Hide 
raised or lowered figures if they form a diminished interval options in the 
Figures section of the Figured Bass page of Engraving Options. 

In a similar vein, you can determine how Dorico infers intervals when inputting 
figured bass via the popover using the Interpretation of diminished intervals 
during figured bass input option on the Figured Bass page of Note Input 
Options. 

Cautionary alterations. Dorico can also calculate cautionary alterations for figured 
bass and automatically add cautionary accidentals to figures to remove ambiguity 
for the continuo player. To enable this behaviour, set Cautionary alterations to 
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either Show in same bar or Show in same and following bar in the Accidentals 
section of the Figured Bass page of Engraving Options. 

Resetting figured bass. If you used the Follow input literally option when inputting 
figured bass via the popover and later want to reset some or all of the existing 
figures in your project so that they will update in response to changes to the 
engraving options for figured bass, you can reset them by selecting one or more 
stacks of figures and choosing Edit ▶ Figured Bass ▶ Reset Figured Bass. 

The converse operation is Edit ▶ Figured Bass ▶ Force Current Appearance, 
which effectively fixes the appearance the selected figures, as if you had input them 
with Follow input literally activated. This means that if you subsequently change 
the figured bass engraving options, these figures will not update. 

Appearance of figured bass. The Accidentals section of the Figured Bass page of 
Engraving Options provides a choice between using accidentals and using figures 
annotated with slashes to indicate raised and lowered figures. The Design section 
provides further options for the precise choice of annotated figures for the raised 
fifth and raised sixth, as well as a choice between using the traditional bold 
appearance for figures and using the numerals from a regular text font. 

If you want to use a different font, you can either set Figured bass appearance to 
Plain font, which tells Dorico to use the Figured bass plain font style that you can 
edit in Engrave ▶ Font Styles, or you can choose Bold font, then edit the 
individual music symbols used in the Figured Bass category of Engrave ▶ Music 
Symbols. If you choose to use the plain font, you should also ensure that 
Appearance of raised or lowered figures is set to Always use accidentals, as a 
regular text font does not contain the annotated figures necessary to show raised 
intervals. 

Further options for hold lines and suspensions are provided, including the option to 
show a single hold line for a set of figures instead of one hold line for each figure in 
a column of figures, and the vertical position of that single line if shown. 

Dorico performs sophisticated automatic kerning for figured bass across the width 
of the system, dynamically adjusting the line spacing between each row of figures 
to ensure that every combination of figure plus accidental is clear, even at small 
sizes. Options for the default distances between accidentals and figures and 
between rows of figures can be found in the Vertical Positioning section of the 
Figured Bass page of Engraving Options. 

Engrave mode. You can nudge columns of figures in Engrave mode by holding Alt 
and using the arrow keys; if you nudge a column of figures with hold lines shown, 
the hold lines will move with the figures, and will always be kept horizontal. The 
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start and end offset of each hold line can also be adjusted left and right if required. 
You can drag stacks of figures with the mouse to position them if you prefer. 

Further developments. It is not yet possible to show figures within brackets, and 
this is planned for future releases. 

Dorico 3.5’s support for figured bass is not intended to meet the requirements of 
using figured bass as part of a broader set of notations used in academic writing 
for harmonic analysis, but expanding the tools for harmonic analysis is also planned 
for future releases of the software. 

Condensing for divisi and section players O 

Building on the unique condensing features introduced last year, Dorico 3.5 now 
expands condensing in two important new ways: it is now possible for section 
players to participate in condensing, and divisi passages written for section players 
can also be condensed. 

Condensing for section players. When writing for ensembles like concert and wind 
band, it is often the case that, for example, the Clarinet 1 part will actually be 
played by a number of clarinettists all playing the same music. In Dorico 3.0, if you 
wanted to create a condensed conductor’s score for a wind or concert band score, 
you would have to use solo players instead of section players; this restriction has 
now been lifted. 

To enable condensing for section players, set the new Section players option in 
the Condensing section of the Players page of Layout Options to Condense 
divisi and adjacent players. If you are writing for an ensemble that mixes section 
players in both the wind and string sections, you may also wish to activate Exclude 
adjacent violin section players from condensing, which will prevent Violin 1 and 
Violin 2 from condensing. 

Once you have activated Condense divisi and adjacent players and clicked 
Apply to confirm your changes, you will see the automatically detected condensing 
groups for the section players in the layout listed in Groups to exclude from 
condensing, so that you can prevent specific section players from condensing. 

You can create custom condensing groups for section players, but you cannot mix 
section and solo players in the same custom condensing groups, and the section 
players must themselves be adjacent to one another in the layout to be permitted 
to condense. 

It is also possible to define manual condensing for condensing groups consisting 
of section players in Engrave ▶ Condensing Change if required. In general, 
condensing for section players works identically to condensing for solo players. 
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Unison labelling for condensed section players. When all section players are 
playing in unison, instead of using an indication like “a 2”, it is instead customary to 
write “unis.”, or possibly “all”. To that end, a new option Text for unison indication 
for section players has been added to the Condensing page of Engraving 
Options, allowing you to customize the label to be used. This text is also now used 
when you use Edit ▶ Staff ▶ Restore Unison to end a divisi passage. 

Condensing for divisi. When writing divisi passages for string section players, 
Dorico already provides a certain amount of flexibility in how the music is laid out, 
dynamically handling the point at which the music moves from unison to divisi and 
vice versa, automatically filling in the part of the system before or after the divisi 
material with unison music. However, it has not hitherto been possible to show the 
divisi material on a smaller number of staves in the conductor’s score and still show 
it distributed between several staves in the instrumental parts. That is what the new 
support for condensing divisi music makes possible. 

To enable condensing for divisi, set the new Section players option to either 
Condense divisi or Condense divisi and adjacent players in the Condensing 
section of the Players page of Layout Options. If you want to prevent Violin 1 and 
Violin 2 from additionally forming a condensing group of their own, and thus 
potentially having their music shown on a single staff when neither is divided, also 
activate Exclude adjacent violin section players from condensing. 

If you are not already familiar with how to use Dorico’s divisi features, we 
recommend you review the material in the Operation Manual here. 

Solo divisions. If you have specified that there should be one or more soloists in 
the Change Divisi dialog, these solo divisions will be excluded from condensing, 
and will always appear on their own separate staves, above the staff or staves for 
the remaining divisions. Solo divisions are likewise excluded from manual 
condensing, so they will always be shown on their own, and labelled accordingly. 

Condensing approach. In general, Dorico condenses music from divisi sections in 
the same way as it condenses music belonging to any other player, though there 
are a couple of differences. Dorico will allow any non-solo division to condense 
with any other non-solo division, regardless of order; it does not require that the 
divisions be adjacent or consecutively numbered in order for them to be 
condensed on the same staff. 

Any divisi change is considered by Dorico as a new phrase for the purposes of 
determining the maximum possible condensation. 

Manual condensing. If you want to determine exactly how Dorico should condense 
the non-solo divisions in a divisi passage, create a condensing change at or after 

https://steinberg.help/dorico_pro/v3/en/dorico/topics/notation_reference/notation_reference_divisi_c.html
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the position where the divisi begins, by selecting a note or rest and choosing 
Engrave ▶ Condensing Change. Activate the condensing change for the section 
player in question, then activate manual condensing. Each non-solo division then 
appears in the left-hand list and can be assigned to one or more staves in the right-
hand list, in exactly the same way that you can assign individual solo players in a 
condensing group. 

Unlike manual condensing for solo players, however, as soon as the divisions in the 
music change at the next divisi event, the manual condensing specified in the 
prevailing condensing change will no longer apply, and Dorico will return to 
condensing the music following its standard rules. 

Player and staff labels. In general, player labels for divisi passages are less 
prescriptive than those produced for condensed section players; provided all 
divisions are condensed together, you will see only “div.” at the start of the division 
and “unis.” at the end of the divided passage. Dorico will also try to avoid showing 
a redundant “unis.” label at the start of a divided passage if in fact the music 
happens to still be in unison for a further passage before the material diverges. 

If a subset of divisions is shown on a staff, or if there is a staggered entry where a 
subset of divisions enters after a period of rest, Dorico will qualify the “div.” labels 
for each entrance with the division numbers or names. 

As with player labels for condensed solo players, the content of the player labels 
for condensed divisi passages can be overridden via the Properties panel in 
Engrave mode, or the labels can be hidden by activating the Hide property. 

Staff labels at the left-hand side of the staff will reflect the disposition of the 
divisions at the start of the system: if a system begins with unison music, then no 
division numbers or names will be included in the staff label, but if condensed 
music appears at the start of the system, the labels will include the division 
numbers or names to show which divisions are assigned to which staves. 

Staff labels for condensed divisi passages will also follow the state of the Staff 
labels for identical adjacent solo instruments option on the Staff Labels page 
of Engraving Options, allowing a single group label to appear between the divisi 
staves if desired. 

Ossias. If a section player has music on an ossia staff, that player will be excluded 
from condensing for the system or systems on which the ossia staff appears. 

Further development. As of this release, there are a few limitations for condensing 
divisi passages that we plan to address in future updates. Firstly, Dorico cannot 
currently draw slurs that start in a unison region and cross into a condensed divisi 
passage, or vice versa. Secondly, under some circumstances Dorico will not show 
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a sub-bracket for a condensed divisi passage that has been reduced to a single 
staff. And thirdly, some of the existing issues that affect the boundaries between 
unison and divided passages concerning changes of clef, key signature and time 
signature are still present in this release, and affect both uncondensed and 
condensed divisi passages equally. 

Properties 

Dorico 3.5 introduces a suite of improvements to make working with properties 
easier and more efficient, including improvements to the Properties panel itself, but 
most significantly providing additional feedback about and control over the scope 
of changes made to properties: in other words, whether changing a property will 
affect only the current layout, or whether the change will affect all layouts. 

All of these new tools are accessed via a new bar that has been added at the top 
of the Properties panel when open. 

Local versus global scope. Some properties set on an item are global, that is they 
affect that item in every layout in which it appears, while others are local, and affect 
that item only in the layout in which the property is set, while others still affect that 
item only in the specific music frame chain in which it appears in one particular 
layout. However, it is not especially straightforward to know at a glance whether a 
property will apply globally or locally when you activate or change its value. 

If a property appears in the Properties panel without a slide switch to activate it, 
then that property is global, and always applies to that item in all layouts. If a 
property appears with a slide switch and is shown in Write mode, then it may either 
apply globally or locally. If a property is only shown in Engrave mode, then it will 
only apply locally, and will usually apply in the most localized scope possible, i.e. to 
the current music frame chain only within the current layout. 

This is a very powerful system, allowing a great deal of flexibility in how items 
appear and are positioned between different layouts, all designed in service of the 
goal of making it possible to achieve whatever appearance is desired in the full 
score and instrumental parts without requiring separate project files for score and 
parts. But it may well be the case that you would prefer a property that is set locally 
to apply globally, and until now this has required the use of Edit ▶ Propagate 
Properties, which copies the properties of selected items from the current layout 
to all other layouts in which the item appears. As of Dorico 3.5, there is now a 
simpler and easier way. 

Specifying property scope. At the right-hand side of the new bar at the top of the 
Properties panel are a pair of buttons, Set local properties: Locally / Globally. 
This allows you to specify whether properties that would normally be set locally 
should instead be set globally. 
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For example, you might want the Gradual type property for a gradual dynamic, 
which affects whether it appears as a hairpin or a text instruction, to take effect not 
only in the current layout, as it does by default, but in all layouts. Before you set the 
new value, first set Set local properties to Globally. Now, when you change the 
value of the Gradual type property, the value you set will apply to all layouts. 
Notice also that the Gradual type label is now shown in bold type: this denotes 
that this is a local property that has been set with global scope. 

When you set a property, if this property already has a conflicting value in another 
context, Dorico will respect the current setting of Set local properties to 
determine what happens to the existing values: if you request global scope, any 
local values for that property will be removed, so that the global value will take 
effect in all layouts. By contrast, if Set local properties is set to Local, you can still 
set a property in one layout with a local scope, even if the property has previously 
been set with global scope; the local scope acts as an override to the global value. 

Viewing property scope. At the left-hand side of the new bar at the top of the 
Properties panel is a new set of controls for Show. Click Local Only to filter only 
those properties that will apply locally, i.e. either in the current layout, or in the 
current music frame chain within the current layout; click Global Only to filter only 
those properties that will apply globally, i.e. to all layouts; or click All to show all 
properties. 

Properties filtering. At the left-hand side of the new bar at the top of the Properties 
panel is a search box, which allows you to type the first few letters of a property 
group or individual property to instantly show only the matching property groups 
and individual properties. You can even type the first letter of each word of an 
individual property: for example, with a note selected typing pso will instantly 
narrow the set of properties to Playback start offset. 

Filtering only set properties. The final pair of buttons at the left-hand side of the bar 
at the top of the Properties panel allow you to toggle between showing only those 
Properties that are currently set for the selected items and showing all properties. 
For items that have many properties, such as notes, this is a useful way to get an 
overview of which properties are actually set. 

Propagate Properties. In previous versions of Dorico, Edit ▶ Propagate Properties 
works by copying the properties from the selected item in the active layout into all 
of the other layouts in which that item appears. However, if you subsequently 
create a new layout in which that item appears, the existing property value does not 
propagate automatically to the new layout. 

From Dorico 3.5, Propagate Properties takes advantage of Dorico’s new ability to 
set properties globally. This has the advantage that if you do subsequently create a 
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new layout in which this item appears, the global property value will automatically 
be inherited by the new layout. 

Other edits that set properties. A variety of other editing operations in Dorico work 
by setting properties, and all of these operations now also respect the state of Set 
local properties. For example, if Set local properties is set to Global, when you 
flip the direction of a note’s stem via Edit ▶ Flip, that edit will automatically apply in 
all layouts. 

Similarly, when nudging or dragging staff-attached items in Engrave mode, those 
adjustments will apply globally if Set local properties is set to Global. 

Manual staff visibility changes 

The Vertical Spacing page of Layout Options contains options for specifying 
whether empty staves should be hidden for each layout, on all systems, from all 
systems following the first system, or whether they should be shown in all systems. 
You can also specify certain players as exempt from hiding empty staves. (In 
previous versions, this section was called Hide Empty Staves, but is now called 
Staff Visibility.) 

Dorico 3.5 adds new tools to override these layout-wide settings at any system 
break, allowing you to specify which staves should be hidden and which should be 
shown – whether or not they are empty – from that point onwards. This is called a 
manual staff visibility change. 

To create a manual visibility change, either: 

§ Select a note, rest or other item at the position from which you want to 
change staff visibility, and choose Edit ▶ Staff ▶ Manual Staff Visibility to 
add a system break at that point and show the Manual Staff Visibility 
dialog; or 

§ Select an existing system break signpost and type Return, or double-click 
the signpost, to open the Manual Staff Visibility dialog. 

The dialog appears: 
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The dialog shows a list of the staves that are visible at that point. Instruments with 
multiple staves – such as grand staff instruments like piano, violin section players 
with divisi, or instruments to which extra staves have been added – appear as 
multiple entries in the list, with each staff annotated with a letter in parentheses. 

To change the visibility of a staff, first activate the slide switch corresponding to the 
staff, then choose from the three options: 

§ Reset: removes any prevailing override set in an earlier manual staff 
visibility change, so that from this point onwards, the staff will either be 
hidden or shown as determined by what is set in Layout Options. 

§ Show: forces the staff to be shown from this point, regardless of whether 
or not it is empty. 

§ Hide: forces the staff to be hidden from this point, regardless of whether or 
not it is empty. 

An action bar provides quick access to showing, hiding, or resetting the state of all 
staves with a single click. 

To remove the manual staff visibility change, you can simply delete the system 
break. If you want to retain the system break at that position, open the Manual 
Staff Visibility dialog and deactivate the slide switches for each staff. 

Clef and transposition overrides O	
When preparing instrumental parts for wind and concert bands, or for ensembles 
with flexible instrumentation, it is often necessary to provide parts for the same 
instrument written in a variety of transpositions. Dorico 3.5 introduces an easy way 
to achieve this by creating one or more additional part layouts for a given player, 
then overriding either or both the clef and transposition of the part. 

Creating a new part layout. To create a new part layout, switch to Setup mode, and 
in the Layouts panel on the right-hand side, click  to create a new part layout. By 
default, empty part layouts have all flows assigned to them, but no players. To 
assign a player to the part, simply activate the checkbox in the Players panel 
belonging to the player for whose instrument you want to create a new part. The 
part’s name automatically updates from Empty Part to the name of the player now 
assigned to the layout, which may include the transposition of the instrument. 

By default, the instrument name that appears at the top left-hand corner of the first 
page and in the header on subsequent pages of instrumental parts uses the 
{@layoutName@} token, so in order to display the updated transposition in the 
new part, edit the layout name by double-clicking it in the Layouts panel in Setup 
mode. If you want to include a flat symbol in the new name, type the token 
{@flat@}, which will automatically be displayed as a flat symbol in the layout itself. 
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Opening the dialog. Once you have created your new part, ensure it is selected in 
the Layouts panel in Setup mode, then right-click and choose Clef and 
Transposition Overrides from the context menu, or choose Setup ▶ Clef and 
Transposition Overrides. If you will find yourself using this feature often, you can 
of course assign a custom key command on the Key Commands page of 
Preferences. This dialog appears: 

 

The table at the top of the dialog lists the instruments in the layout, and the 
overrides that are set. Select an instrument from the list, then make your choices 
using the options in the bottom half of the dialog. 

Overriding the default clef. By default, a clef looks the same in both a transposed 
score and when viewed at concert pitch. When you activate the slide switch next 
to Clef for first staff, the clef selector under Transposed pitch becomes enabled. 
Unless you explicitly then activate the slide switch under Concert pitch, the clef 
you choose under Transposed pitch will be used both when viewing the layout in 
transposed pitch and at concert pitch; if you require a different clef in concert 
pitch, be sure to activate the slide switch under Concert pitch and then choose 
the desired clef. 

If the instrument has two staves, the second row of clef selectors will be enabled; 
and in the very rare case of an instrument with three staves, the third row will be 
enabled. 

The overrides that you create here affect the default clef at the start of each flow in 
the layout, unless you have created an explicit clef change at the start of the flow, in 
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which case that will still take precedence. Any later clef changes in the flow will still 
appear as normal. 

Overriding the transposition. Instruments can transpose by any interval in a 
transposing layout and can optionally transpose by one or more octaves in a 
concert pitch layout; this latter kind of transposition is for instruments such as 
piccolo, guitar, double bass, the tenor voice, and low wind and brass instruments, 
that are conventionally written shifted by one or more octaves from their sounding 
pitch. 

Activate the slide switch under Transposed pitch to specify the transposition in a 
transposed layout. For, say, a Clarinet in B♭, Written middle C sounds as should 
be set to Bb3. You can type directly into the spin box to specify the note name and 
octave, or increment or decrement the value with ↑/↓ or by clicking the paddles; 
hold Shift to raise or lower by an octave. 

If you want to additionally specify an octave transposition in a concert pitch layout, 
activate the slide switch under Concert pitch, then specify the appropriate octave. 
A double bass, for example, should be set to C3, while a piccolo should be set to 
C5. 

Used chord diagrams grid 

Chord diagrams, which show how particular chord voicings should be fingered on 
the fretboard of a guitar or other fretted instrument, are very useful for 
communicating precisely how a chord should be played, but they take up a 
reasonable amount of room when printed at a legible size above an existing vocal 
or keyboard part. Chord diagrams are typically provided for rock and pop songs, 
which normally use a relatively limited number of different chords and voicings, in 
which case it may not be necessary to show the chord diagram above each chord 
symbol: the player will quickly be able to learn which voicing to use, and so seeing 
only the chord symbol is normally sufficient. 

Instead of showing the chord diagrams throughout the song, therefore, it can be 
more efficient – both in terms of reducing the amount of vertical space needed for 
each system, and to help guitarists get the voicings under their fingers – to show 
the chord diagrams in a grid above the first system of the music, in the manner 
popularized by rock and pop music publishers. 

Dorico 3.5 introduces a one-click solution to add a grid of the chord diagrams 
used in a flow above the first system. 

Adding the used chord diagrams grid. To show the grid of chord diagrams, go to 
the new Chord Symbols and Diagrams page of Layout Options, and activate 
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Show chord diagrams used at start of flow. The options below determine the 
size and placement of the chord diagrams: 

§ Tuning for chord diagrams at start of flow specifies the tuning to be 
used, defaulting to Standard guitar tuning but allowing you to choose 
from any of the tunings defined in the project. 

§ Maximum number of chord diagrams per row specifies how many chord 
diagrams can appear in a single row in the grid, though note that if the 
combination of page width, gap between chord diagrams and scale factor 
prevent this maximum from being reached, Dorico will always drop chord 
diagrams off the row to prevent them from becoming too crowded. 

§ Scale factor for chord diagrams determines by how much Dorico should 
enlarge or reduce chord diagrams shown in the grid compared to their 
normal size when displayed along with chord symbols above the music, 
defined by the values defined on the Chord Diagrams page of Engraving 
Options. It can be helpful to show the chord diagrams in the grid at the 
start of the flow a little larger than they would normally be shown in the 
music, to make the shapes more legible. 

§ Distance between chord diagrams specifies the horizontal distance 
between chord diagrams on the same row. This, and the other following 
measurements, are shown in your preferred measurement unit, as defined 
on the General page of Preferences. 

§ Distance between rows specifies the gap between rows of chord 
diagrams. 

§ Gap above top row of chord diagrams specifies the gap between the 
flow heading, if shown, or the top of the music frame, if flow headings are 
not shown. 

§ Gap below bottom row of chord diagrams specifies the gap between 
the bottom row of chord symbols and the first system of music. 

Choice of chord diagrams. Chord diagrams are added to the grid at the start of the 
flow in the order in which they appear in the music. Each voicing is added only 
once, so while the grid will show every voicing used in the music, the chords as 
shown can not necessarily be played directly in the order in which they are shown 
in order to perform the song: the guitarist must still refer to the chord symbols in 
the music to know which chord should be played when. 

Editing chord diagrams in the grid. The chord diagrams shown in the grid at the 
start of the flow cannot be selected or edited, but as you edit the chord diagrams 
in the music, the chord diagrams in the grid will update. 

When showing the used chord diagrams at the start of the song, it is customary 
not to show them in the music along with each chord symbol, but in order to 
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change the voicing that appears in the grid at the start, you will need to show them 
in the music temporarily, which is done via the Players panel in Setup mode, and is 
described in the Operation Manual here. 

It is therefore advisable not to show the used chord diagrams at the start of the 
flow until the music is more or less complete. 

Graphic slices O 

When preparing documents or resources in other applications, you may sometimes 
need to include small musical examples, and exporting examples from Dorico that 
are smaller in scope than a whole page has historically been a little labour-
intensive, either requiring you to set up dedicated layouts with appropriate page 
and margin settings to encompass only the music to be exported, or to post-
process the graphics exported from Dorico in a graphics application. 

Dorico 3.5 introduces a new tool in Engrave mode to make it quick and easy to 
export graphics smaller than a page: graphic slices. A graphic slice is a rectangular 
area of a page, stored persistently in the project so that you can re-export it again 
at any time in the future. Each slice can have its own unique name, and can be 
exported in any of the graphics formats supported by Dorico, several of 
which provide further choices concerning resolution and whether or 
not the graphic should be exported in color or monochrome. 

Creating a graphic slice. To create a graphic slice, switch to Engrave mode, and 
activate the graphic slice tool in the toolbox on the left-hand side of the screen, 
which shows the Graphic Slices panel. 

Click Create Slice, then click and drag around the region you want to be exported. 
As you drag, a rectangular frame appears on the page. Release the mouse button, 
and the frame is finalized. You can adjust the position of the frame without 
adjusting its size by clicking on any part of its outline, then either clicking and 
dragging with the mouse, or holding Alt and using the arrow keys (add Ctrl or 
Command for larger steps). To adjust the size of the frame, click and drag any of 
the handles around the outline of the frame, or use Tab to select a handle, then 
navigate to the handle you want to move using the arrow keys; once you have the 
desired handle selected, hold Alt and use the arrow keys to move that handle, 
changing the dimensions of the graphic slice frame. Unlike other types of frame, 
graphic slice frames can be created outside the grey page margins, so that you 
can capture brackets and braces, which are sometimes drawn outside the margins. 

Specifying export options. Once a graphic slice has been created, it appears in the 
list of graphic slices in the panel on the left-hand side in Engrave mode, ordered by 
the page on which it appears. To specify the filename that will be used when 

https://steinberg.help/dorico_pro/v3/en/dorico/topics/notation_reference/notation_reference_chord_diagrams_hiding_showing_t.html


 

 
Dorico 3.5 Version History Page 35 Steinberg Media Technologies GmbH 

exporting the slice, double-click the first column in the list, and type the desired 
name. 

With the slice selected, the controls below the list show its other properties, 
including the folder into which the slice will be exported. By default, graphic slices 
are exported into the same folder as the project file itself, but you can specify 
another folder here, and subsequent slices you create will default to the last-
chosen folder, if it differs from the project’s save location. 

Four formats are provided for export: two bitmap graphics formats (PNG and TIFF), 
and two vector graphics formats (PDF and SVG). For the bitmap formats, you can 
specify the Resolution to be used, in dots per inch. Vector graphics formats are 
always scalable to any size, so there is no possibility to specify the output 
resolution for PDF or SVG. For all formats, you can specify whether the resulting 
graphic should be Color or Mono. When you choose Mono, be aware that this 
means monochrome rather than grayscale, so any non-white items will be exported 
as pure black. 

Exporting slices. To export all slices, ensure that no slices are selected in the list in 
the panel, and click the Export All button at the bottom of the panel. To export a 
selection of the defined slices, select the slices to be exported in the list; the 
button at the bottom of the panel now reads Export Selected, and clicking this will 
export only the selected slices. If any of the slices have been exported before to 
this location, you will be prompted whether to overwrite the existing files. 

Hollywood-style parts 

When producing performance materials for recording sessions for film, TV and 
video game productions in Hollywood, there are certain conventions followed by 
the largest of the specialist music preparation offices in Los Angeles that are very 
laborious for them to complete in every part that they work on. 

Before the advent of computerised engraving, parts were hand-copied on standard 
printed manuscript paper, meaning that each page would be pre-ruled with a fixed 
number of staves. The copyist would copy the music out, giving great consideration 
to the casting off of the music in order to ensure maximum legibility, but without 
particular concern for whether the cue ends at the end of a page, or indeed even 
the end of the system. As a result, there would often be several blank staves at the 
end of a cue, and even some blank space at the end of the final system: 
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Since the copying process was computerized, some music preparation offices 
have chosen to continue to emulate this aspect of hand-copied parts, partly as an 
evocation of the time-honored traditions of the craft of music copying, and partly 
because there can be some practical benefits to having empty staves for the 
players to be able to make notes and write in any additional cues they may be 
asked to play. 

However, emulating the look of printed manuscript paper in music notation 
software is not straightforward, and requires the copyist to perform a series of 
manual edits when finishing every single part, all of which takes time and increases 
the risk of introducing errors. 

To make this particular aspect of the process quicker, easier and more reliable, 
Dorico 3.5 introduces the ability to create this kind of special layout in just a few 
clicks: 

§ To ensure that the final system will not be justified unless it is very close to 
being completely full, on the Note Spacing page of Layout Options, set 
Only justify final system in flow when more than n% full to something 
like 95%. 

§ To fill the final page of the layout with blank staves, on the Page Setup 
page of Layout Options, in the Flows section, activate Fill frame with 
blank staves. 

§ Finally, to instruct Dorico to group the blank staves into the same system 
groupings as the preceding systems in the layout, activate Show blank 
staves in systems identical to final flow. 
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§ Normally, clefs corresponding to the clefs in each system are shown in the 
blank staves after the end of the flow, but should you wish clefs not to be 
shown, activate Exclude clefs. 

If Show blank staves in systems identical to final flow is not activated, Dorico 
will simply fill the frame with completely blank staves, with no clefs, brackets or 
braces; in this case, you can determine how many staff lines the blank staves 
should have by editing Number of staff lines for blank staves. 

Blank staves 

As an adjunct to the feature to automatically add blank systems at the end of parts 
for Hollywood recording sessions, it is now also very easy to create blank 
manuscript paper in Dorico 3.5. You can easily create whole pages of blank staves, 
ready to be printed out. If you’re producing printed worksheets or other teaching 
materials for students, it’s likewise simple to include a few blank staves anywhere 
on the page for them to write in. 

To create a frame full of blank staves: 

§ Switch to Engrave mode, and activate the frame editing tool in the toolbox.  
§ Either create a new empty page or otherwise make space on the current 

page for a new music frame, and drag one out.  
§ Open the flow filter menu in the top left-hand corner of the music frame, 

and click None – see Flows on page 42 below for more details. This 
removes whichever flow or flows Dorico had automatically assigned to the 
new music frame. 

§ With the frame itself selected, activate Fill with blank staves in the Music 
Frame group of the Properties panel. 

Dorico will create as many blank staves as fit in the height of the frame, using the 
global space size defined on the Page Setup page of Layout Options, and the 
gaps defined on the Vertical Spacing page. If you want to change the number of 
blank staves shown in the frame, you can change the height of the frame, or 
activate the Blank staff count property and set that to the desired number. 

Unlike when following on from a flow, the blank staves cannot be grouped into 
systems, so they cannot show brackets and braces or clefs. It is also not possible 
to enter music into these blank staves in Dorico: they are purely cosmetic and 
intended for printing only.  

Keda Indian Drum Basics sounds 

In partnership with our friends at Keda Music, we are pleased to include a set of 
basic samples for four traditional Indian drums: tabla, dhol, pakhawaj, and dholak. 
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Each of the patches in the Keda Indian Drum Basics set provides a consistent set 
of playing techniques, mapped as follows: 

Larger drum: 

§ C4 (note 60): Ke (closed) 
§ D4 (note 62): Ge (open) 
§ E4 (note 64): Ga (open) 
§ F4 (note 65): Gi (open) 

Smaller drum: 

§ C5 (note 72): Ta (muted open) 
§ D5 (note 74): Te (closed) 
§ E5 (note 76): Tu (open) 

When you create a Tabla percussion kit in a new project in Dorico 3.5, it will 
automatically use the new Keda Indian Drum Basics sound and percussion map. 

For more information about Universal Indian Drum Notation, resources for 
composing for tabla and other Indian drums, and music for these instruments, 
please visit www.keda.co.uk.  

Improvements 

Barlines O 

Default barline type for flow. A new option Default barline type has been added to 
the Barlines page of Notation Options, allowing you to specify what type of barline 
should be used for bars for which no explicit barline type has been specified. 

The option Single barlines between staves has been moved from the Barlines 
page of Engraving Options, where it applied to the whole project, to the Barlines 
page of Notation Options, so that it can vary for each flow. 

Beams O 

Beams starting and ending with rests. The Rests in beam groups option on the 
Beam Grouping page of Notation Options has a new choice, Allow rests within 
beams and at start and end of beams. When this is chosen, Dorico will allow 
beamed groups to begin or end with rests without requiring stemlets to be shown. 

Two new options have been added to the Stems section of the Notes page of 
Engraving Options to provide control over the appearance of beams extending to 
or from rests at the extremes of the beam group: Ideal distance between 
innermost beam and rest and Minimum distance between innermost beam 
and rest, counterparts for the analogous options for stemlets. 
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Rests and secondary beam groups. In previous versions, if you chose to allow rests 
within beamed groups, Dorico would always break the secondary beam at the rest 
if the duration of the rest differed from the duration of the surrounding notes, as 
follows: 

 

If you set the new Rests and secondary beam groups option on the Beam 
Grouping page of Notation Options to Preserve secondary beams over rests 
where possible, this figure will be notated as follows: 

 

Provided the rest is of the same or shorter duration than the duration indicated by 
the secondary beam, the secondary beam line is allowed to continue unbroken. 

Disabling automatic secondary beam breaks. A new option Approach for 
secondary beam groups has been added to the Secondary Beam Groups 
section of the Beam Grouping page of Notation Options, allowing you to choose 
between Dorico automatically splitting beamed groups at secondary subdivisions 
or keeping a single primary beam group with no secondary beam breaks. 

Beam slants for shallow ideal slants. Some European publishers prefer very 
shallow slants for beams, typically choosing slants of a quarter space for intervals 
of a second, and a half space for any interval of a third or more. You can emulate 
this appearance by adjusting the values in the Slant for beams of more than two 
notes and the Slants for narrow beams options in the Slants section of the 
Beams page of Engraving Options. 

However, when using an ideal slant of a quarter space, beamed groups where one 
end of the beam sits on the outermost staff line will not maintain the ideal quarter 
space slant because of a rule that prevents the inside of a beam line from being 
positioned closer than half a space to the outermost staff line, as this can produce 
an undesirable wedge. In a similar vein, for certain combinations of staff positions, 
32nd notes (hemidemiquavers) will end up producing a slant of one whole space 
when the beams end within the staff, because the standard beam thickness and 
separation limit the available slants within the staff that do not produce wedges to 
a whole space slant or no slant at all. 
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Some engravers may find that the cure is worse than the disease, and that they 
would rather have shallower slants and wedges than beams with inconsistent and 
potentially jarring steeper slants. To that end, two new options have been added to 
the Advanced Options section of the Slants section of the Beams page of 
Engraving Options: 

§ Preserve ideal quarter-space slant for beams positioned near the 
outer staff line allows inner beam lines to end at any position relative to 
the outermost staff line if the beam would ideally use a quarter space slant; 
and 

§ Preserve ideal quarter-space slant for 32nd note beams allows 
beamed 32nd notes to use their ideal quarter space slant inside the staff. 

Chord diagrams 

Custom tunings. If you customize the number of strings or the tuning for a fretted 
instrument in the Edit Strings and Tunings dialog, that tuning is now made 
available as a choice for displaying chord diagrams in your project, both in the 
Chord Diagrams submenu of the context menu for the Players panel in Setup 
mode, and for the grid of used chord diagrams, chosen on the Chord Symbols 
and Diagrams page of Layout Options. 

Clefs 

Octave reminder clefs. A new Clefs page has been added to Notation Options, 
with a new Clefs with octave indicators option. 

By default, Dorico ignores the octave reminder on clefs, for example the 8 below 
the G clef commonly used for the tenor voice, because it is conventional for music 
for instruments that are written an octave higher or lower than they sound to be 
written that way regardless of whether an octave reminder clef is used: for 
example, although it is conventional for a tenor voice to be written with an octave 
reminder clef, it would be unconventional for a piccolo or double bass to be written 
with such a clef. 

However, in the middle of the 20th century, some composers, including Britten, 
began using octave reminder clefs as an alternative notation for octave lines in 
extended passages, reasoning that an octave clef adds less visual noise than an 
ongoing octave line. 

Dorico now supports this convention: you can set Clefs with octave indicators to 
Respect octave indicator. O 

Octave shifts for clef changes. A number of different conventions have evolved 
over the years and in different countries for the use of clefs in parts for instruments 
such as horn and bass clarinet. The bass clarinet convention, for example, known 
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as Russian notation uses both treble G and bass F clefs, with the G clef written a 
ninth higher than sounding pitch, and the F clef written a second higher than 
sounding pitch. Horn parts in 19th century editions are sometimes written in “high 
bass clef,” meaning that lower notes are written in bass clef, but rather than being 
written a fifth higher than sounding pitch as is usual today, the notes are written a 
fourth lower than sounding pitch. 

In order to accommodate these different conventions, it is necessary for the 
effective transposition of the instrument to change depending on which clef is 
being used, and this is now possible by activating the new Octave shift property 
for a selected clef change, then specifying the number of octaves by which the clef 
should transpose the following music. If you need to do this from the very start of 
the part, add an explicit clef change at the beginning of the first bar. 

Condensing O 

Fully-qualified unison labels. A new option Player labels for unison passages 
has been added to the Condensing page of Engraving Options, allowing you to 
choose whether a player label such as “1.2.3 a 3” should include the “a 3” 
qualification. If you feel that this is redundant, choose Exclude “to” indication. 

Separators for player labels. New Comma value for Separator between player 
numbers option on the Condensing page of Engraving Options, allowing you to 
separate player numbers in player labels on condensed staves with a comma if 
desired. 

Performance improvements. The speed of note input and editing when Edit ▶ 
Condensing is enabled has been significantly improved. Enabling and disabling 
condensing in a layout is also now faster than in previous versions. 

Filter for condensing changes. A new command Edit ▶ Filter ▶ Condensing 
Changes has been added, allowing you to select or deselect condensing changes. 

Cues O 

Cueing divisi. It is now possible to cue from one division to other divisions within 
the same section player. 

Engrave mode O 

Copy Staff Spacing. Choosing Engrave ▶ Staff Spacing ▶ Copy Staff Spacing, 
the initial value in the 'Page' spin box now takes into account a selected item in the 
music, instead of only relying on a selected staff spacing handle. 
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Flows O 

Flow filters in Engrave mode. It is now possible to specify that a music frame 
should have no flows assigned to it using the flow filter menu in the top left corner 
of the music frame, accessible when editing frames in Engrave mode. 

 

To specify that a music frame should be assigned no flows at all and should 
instead be filled with blank staves, click Blank Staves in the bar at the bottom of 
the flow filter menu; conversely, to specify that all flows should be assigned, click 
All. 

Flow headings. If you specify in Layout Options that a layout should never use flow 
headings, but then apply a flow heading change to a particular page in your layout, 
Dorico will now show flow headings on that page, and on following pages as 
appropriate, if the flow heading change is ongoing. 

Guitar tablature 

Guitar bend runs. Multiple successive guitar bends can now effectively be chained 
together, and will be displayed correctly in tablature: for example, an initial bend of 
a half-step (semitone) followed by another bend in the same direction, as shown 
below: 

 

Further engraving options for the positioning of guitar bends in staff notation have 
been added, including an option that determines whether bends should stop 
before an accidental on the bent-to note, or should instead be positioned outside 
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accidentals, so that the bend can approach the center of the notehead more 
directly at the expense of occupying more vertical space. 

Vibrato arm dips, scoops and dives. Dorico now provides simple ways to notate 
the most common techniques performed with an electric guitar’s vibrato arm, 
informally known as the whammy bar, or tremolo arm. 

To create a dive, create a smooth fall using the appropriate 
button in the Jazz section of the Ornaments panel in Write 
mode, then add the w/bar indicator using the appropriate button 
in the Guitar section of the same panel, or type wbar into the 
Shift+O popover. 

To create a dive and return, input the starting and returning 
note of the dive, with the target note between them. Type 
vibbend into the Shift+O popover or use the bend w/bar 
button in the Guitar section of the Ornaments panel in Write 
mode to create two bends. You can also convert a regular 
bend to use the vibrato arm by activating the Use vibrato arm 
property in the Guitar Bends group of the Properties panel. 

To create a pre-dive, create a pre-bend by activating the Pre-bend interval 
property in the Guitar Techniques group of the Properties panel and specify the 
desired interval, then activate the Vibrato bar pre-bend property. 

To create a scoop, select the note before which the scoop 
should appear, and click the appropriate button in the 
Guitar section of the Ornaments panel, or type vibscoop 
into the Shift+O popover. If you want to add the w/bar 
indicator, select the region of notes that should be 
enclosed in the w/bar indication, then create it using the 
appropriate button in the same section of the Ornaments panel. 

To create a dip, select the note on which the dip should 
appear, and click the appropriate button in the Guitar section 
of the Ornaments panel, or type vibdip into the Shift+O 
popover. By default, a dip uses the interval of a half-step 
(semitone); to indicate a whole step (tone), select the dip 
and set the Interval above property in the Ornaments group 

of the Properties panel to 1. To indicate a continuous run of dips without re-striking 
the pitch, you may wish to bracket the following notes, which you can do by 
choosing Edit ▶ Notehead ▶ Toggle Round Brackets. 
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None of the vibrato arm techniques currently have any effect on playback, but this 
is planned for a future version. 

Options for the default placement and position of vibrato arm techniques can be 
found on the Guitar Techniques page of Engraving Options. 

Hammer-on and pull-off. Dorico can now display hammer-on and pull-off indicators 
both in tablature and in staff notation. 

 

If you want to indicate hammer-on and pull-off only using a slur without showing 
the explicit H and P markings, it is sufficient simply to create slurs in the usual way: 
select the notes that should be slurred and type S. You can add H or P to an 
existing slur by selecting the notes under the slur and activating the Technique 
property in the Guitar Techniques group of the Properties panel, choosing either 
Hammer-on or Pull-off as appropriate. 

To add both the slur and the H or P in a single operation, select the notes over 
which the technique should take effect, type Shift+O to open the ornaments 
popover, and type hammer or ho for a hammer-on or pull or po for a pull-off. You 
can enter hp, hopo, hammerpull, lig or ligado to add both hammer-on and pull-
off indications at the same time. 

By default, Dorico will show a single H or P centered over the slurred notes, but if 
you would prefer to show H or P on each note, set Appearance of guitar 
techniques on adjacent notes on the Guitar Techniques page of Engraving 
Options to Show on each note. 

You can adjust the placement of the hammer-on and pull-off indicators by 
activating the Technique placement property in the Guitar Techniques group in 
the Properties panel. 

Tapping. Right- and left-hand tapping can be displayed for selected notes, both in 
tablature and in staff notation. Select the notes you want to be played using the 
tapping technique, then activate the Technique property in the Guitar Techniques 
group of the Properties panel and choose either Tapping (for right-hand tapping) 
or Left-hand tapping. Right-hand tapping is notated by default as a small, bold T 
above the tapped note, but can alternatively be notated using a plus sign or small 
filled circle. Left-hand tapping is always notated using the small, bold T. 
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You can also add tapping using the Shift+O popover, entering tap for right-hand 
tapping, lhtap for left-hand tapping, and tappull or lhtappull for tapping combined 
with a pull-off. 

To change the default appearance of right-hand tapping, choose the desired 
appearance from the Tapping appearance option on the Guitar Techniques page 
of Engraving Options. 

Visibility on tablature. You can determine whether guitar techniques such as 
tapping, hammer-on and pull-off should appear on tablature when staff notation is 
also shown using the new Show guitar techniques option on the Guitar 
Techniques page of Engraving Options. 

Tablature with rhythms. It is now possible to display tablature with rhythms 
alongside staff notation. In the Fretted Instruments section of the Players page of 
Layout Options, you can now activate Show rhythms in tablature independently 
of whether staff notation is shown alongside tablature. 

Harp pedaling 

Lowest two strings. The lowest C and D strings on a concert harp are not affected 
by the pedals that can otherwise raise or lower the pitch of every other string; 
harpists will instead tune these strings in advance of playing. Dorico therefore no 
longer considers the lowest two strings of the harp when calculating pedal 
positions, and nor will it show notes in red for the lowest two strings. 

Holds and pauses O 

Breath marks. A new option Vertical position of breath mark has been added to 
the Vertical Position section of the Holds and Pauses page of Engraving 
Options, allowing you to specify whether or not Dorico should adjust the position 
of breath marks taking into account the pitches of the previous or surrounding 
notes. 

Instrument types 

Tenor voice. A new tenor voice instrument that sounds at the same pitch as it is 
written has been added, for use in conjunction with the new option to respect the 
transposition of octave reminder clefs – see Clefs on page 40 above. 

Tres tuning. The default tuning for the tres is now G3, C4, E4, the most commonly 
used tuning in current practice; the more traditional A3, D4, F♯4 tuning is still 
provided. 

Lines 

Alignment for start of horizontal lines. A new Horizontal start position property 
has been added to the Horizontal Lines group in the Properties panel, allowing 
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you to specify whether the start of the line should be aligned with the left-hand side 
of the notehead, or aligned with any accidentals to the left of the notehead. 

Color. Horizontal lines now respect the Color property, if set. 

MusicXML export 

Dynamics. A wider range of dynamics are now included when exporting 
MusicXML. The actual repertoire of immediate dynamics supported by MusicXML 
is reasonably restrictive, and different applications handle them differently, so you 
are advised to proof-read the dynamics after the MusicXML file has been imported 
into the target application. 

Messa di voce hairpins are now included in MusicXML export, and if hairpins use 
an alternative line style – such as a dotted or dashed line – this information is also 
now encoded. 

Notehead types. If a note uses a non-default notehead, that will now be exported in 
MusicXML. This includes support for the seven-shape shape note system that can 
be chosen on the Notes page of Engraving Options. Furthermore, if a notehead 
uses an overridden color, that color will also be exported to MusicXML. 

Tempo. Immediate and gradual tempos are now exported to MusicXML.  

Time signatures. A wider variety of time signature appearances is now exported in 
MusicXML, including common and cut common time, open time signatures 
(exported as senza misura), and so on. 

Unpitched percussion. Percussion instruments are now exported in MusicXML. 
The five-line presentation type for percussion kits is supported, as is the single-line 
presentation type for kits or for individual percussion instruments not treated as 
kits; however, MusicXML has no support for percussion grids with variable number 
of staff lines, so kits using the grid presentation type will instead be exported using 
the five-line staff presentation type. 

MusicXML import 

Playing techniques. Dorico now imports text-based playing techniques from 
MusicXML files, allowing instructions such as pizz. and arco to be imported 
automatically. 

Text items. The Text items option on the MusicXML Import page of Preferences 
is now activated by default. If you had previously tried switching this on, but later 
switched it off again because you were seeing too many duplicate text items for 
tempo and other markings that were imported as text as well as their proper 
semantic type, try switching it on again now: Dorico now does a better job of 
detecting potential duplicates when importing text. 



 

 
Dorico 3.5 Version History Page 47 Steinberg Media Technologies GmbH 

Note grouping O 

Notation Options. The option Notes starting on a beat followed by a rest in the 
middle of the beat has been moved to a new Simple Time Signatures With or 
Without a Half-bar section of the Note Grouping page of Notation Options to 
make clear it also applies to time signatures without a half-bar as well as those that 
do. 

Noteheads O 

Notehead types with multiple symbols. If you design a notehead type using 
multiple symbols, it is now possible to specify how that notehead should be 
positioned relative to the stem by adjusting its offset in the Edit Notehead dialog. 

Note input 

Moving to the staff above or below. When using Edit ▶ Paste Special ▶ Move to 
Staff Above/Below to move notes within tuplets to the staff above or below, a 
tuplet will now be created on the destination staff if necessary, even if it was not 
selected on the source staff. This prevents the rhythm from changing unexpectedly 
when moving material between staves. 

Percussion maps 

Note names. The note name and octave (for example G4) is now shown as well as 
the MIDI note number for each entry in a percussion map in Play ▶ Percussion 
Maps.	

Playback 

Guitar bends. Dorico now plays back guitar bends using MIDI pitch bend. 

Jazz articulations. Dorico now outputs appropriate playback playing techniques 
when it encounters jazz articulations, allowing you to map these notations onto 
dedicated sampled or synthesized performances of these techniques provided by 
your virtual instrument of choice; both NotePerformer and Garritan Jazz and Big 
Band, for example, include some basic jazz articulations. The sounds that are 
included with Dorico itself do not presently support any of these jazz articulations. 

For the purposes of adding support to jazz articulations to your own expression 
maps, the playback playing techniques that Dorico outputs match the name of the 
jazz articulation itself. For example, the scoop jazz articulation maps onto the 
playback playing technique Scoop. 

Velocity editing for multiple notes. It is now possible to edit the velocities of 
multiple selected notes in Play mode. Make a selection of multiple notes in the 
piano roll editor, then in the velocity lane either click at the desired value in line with 
one of the selected notes, or click and drag to the desired value. The velocities of 
all selected notes will be edited, maintaining their relative values. If you want to set 
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all selected notes to the same velocity, specify a single value in the spin box in the 
velocity lane header. 

Pitch bend editing. A new MIDI Pitch bend entry has been added to the menu of 
MIDI controllers in the automation lane, allowing you to add MIDI pitch bend data 
using the pencil and line tools. It is not currently possible to change the pitch bend 
range, so the maximum amount of pitch bend is limited to one whole step above 
and below the played note. 

Updated HALion Sonic SE and Steinberg Library Manager. Dorico 3.5 includes 
the HALion Sonic SE 3.4 and Steinberg Library Manager 3.0.25. These new 
versions will automatically update any previous versions of these components you 
already have installed. 

Reset controllers. If Reset controllers and send ‘all notes off’ when stopping 
playback is active on the Play page of Preferences, Dorico will now additionally 
reset pitch bend for every channel when stopping playback. 

Metronome click. A new Wood Block option has been added to the Click page of 
Playback Options, allowing you to choose between the pitched beep, the 
unpitched digital click, or an acoustic wood block sound for your metronome click. 

Play mode 

Automation lanes. The automation lanes in Play mode now display the effective 
values generated automatically during playback in addition to explicit automation 
data you have added. 

For example, if the instrument uses MIDI CC 1, modulation, to control dynamics, if 
you view the automation lane for CC1, you will see the modulation data Dorico 
generates to realize the dynamics written in the score, together with minor 
variations arising from the humanization settings on the Dynamics page of 
Playback Options. 

Automation data added using the Draw or Line tools is now shown with a shaded 
background behind the region, making it easier to tell it apart from automatically 
generated data. 

Playing technique lane. The tool tip that appears when you hover over a region in 
the playing technique lane in Play mode now shows additional information to help 
you to understand what Dorico is actually doing at any point in playback: in 
addition to listing the expression map in use, it lists the active techniques, any 
intrinsic MIDI effects that are active (such as a modified note length for staccato, or 
modified velocity for accents), which switch is in use, and so on. 
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Editing velocity for multiple notes. It is now possible to edit the velocity of multiple 
selected notes in a single operation. Select the notes whose velocities you want to 
edit – either in Write mode, or by drag-selecting them in the piano roll editor in 
Play mode itself – then click and drag any of the selected velocity bars to edit the 
velocities of all of the selected notes. 

Bar numbers in the ruler. The bar numbers displayed in the ruler in Play mode now 
take bar number changes and pick-up (upbeat) bars into account. 

Print mode 

Default zoom mode. The default zoom mode when switching to Print mode for the 
first time is now set to Whole page rather than Page width. 

Gathering printer information. Some users encountered long delays when starting 
Dorico because one or more of the printers installed on their operating system 
were unavailable – for example, network printers from a work network not available 
on a home network, or a printer that is simply powered off – and the call to the 
printer driver to gather information about the printer’s capabilities was timing out. 
Unfortunately this delay cannot be completely eradicated as it is caused by the 
time-out behavior of third-party printer drivers, but to ensure that any delay does 
not occur on start-up and is instead only incurred when you actually need to print, 
Dorico no longer gathers printer information at start-up, instead doing it only when 
you switch to Print mode for the first time during your working session. 
Consequently, you may see a progress indicator when you switch to Print mode for 
the first time after running Dorico. 

Rehearsal marks 

Rehearsal marks below the system. To display rehearsal marks additionally below 
the bottom staff of the system, activate Also show below bottom staff: 
Rehearsal marks on the Staves and Systems page of Layout Options. 

Rehearsal marks aligned with the systemic barline. New Horizontal offset for 
rehearsal mark aligned with systemic barline option on the Rehearsal Marks 
page of Engraving Options. When rehearsal marks are set to be left-aligned with 
the systemic barline, this offset will be applied for any staff in the middle of the 
system where the rehearsal mark would otherwise collide with the systemic barline. 

Setup mode 

New string ensembles. Three new preset ensembles have been added to the 
Strings category of ensembles, making it quick to add various string sections 
needed for pops and studio orchestras. 
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Slurs 

Slurs over breaks. A new option Interpolate vertical position of slur either side 
of break has been added to the Endpoint Positioning section of the Slurs page 
of Engraving Options. When a slur crosses a system break, it is ideal if the shape 
of the first segment of the slur, prior to the break, is suggestive of the contour of 
the phrase on the other side of the break, so that the player has an idea whether 
the phrase is rising or falling overall. This option, when activated, allows Dorico to 
look ahead to the note at the end of the slur, and interpolate a suitable vertical 
position for the right-hand end of the first segment, before the break, and the left-
hand end of the second segment, following the break.  

This new option is activated in newly created projects, but is switched off in 
existing projects, to avoid changing the appearance of slurs in existing projects in 
unexpected ways. 

Cross-staff slurs. A new option Determine curvature of cross-staff slurs using 
point at which notes cross to other staff has been added to the Avoiding 
Collisions section of the Slurs page of Engraving Options; this option improves 
the shape of cross-staff slurs by more accurately routing the slur around notes on 
both staves. 

This option is activated in newly-created projects, but is switched off in existing 
projects to avoid changing the appearance of cross-staff slurs that you might 
already have tweaked. 

Slurs between notes with mixed stem directions. A new option Slurs starting and 
ending on notes with opposing stem direction has been added to the Endpoint 
Positioning section of the Slurs page of Engraving Options. This option affects 
situations like this one: 

 

in which the slur does not follow too closely the contour of the notes; by setting 
this option to Position stem-side endpoint near notehead, the same situation is 
instead handled like this: 

 

These kinds of situations also arise with slurs that cross from one staff to another, 
where the stem directions are often opposed, and slurs in those situations will now 
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follow the melodic contour more closely. This new behavior is enabled by default in 
newly-created projects, but is switched off in existing projects. 

Adjusting slurs in Engrave mode. In previous versions, each handle of the slur 
moved independently when dragged with the mouse or nudged with Alt and the 
arrow keys, but if you held Alt while clicking and dragging either of the slur’s end 
points, the whole slur would be scaled and rotated, keeping the position of the 
control points in relation to the end points. 

In response to user feedback, Dorico now always moves control points along with 
end points, whether you drag them with the mouse or use Alt and the arrow keys. 
This means that however you move either end point, the corresponding control 
point will also move; but you can still move the control point independently of the 
end point by selecting its specific handle and nudging or dragging it alone. 

Stem-side slurs on notes with flags. Two new options, Horizontal offset from 
stem with flag and Vertical offset from stem with flag, have been added to the 
Endpoint Positioning section of the Slurs page of Engraving Options, allowing 
you to specify a special offset value for slurs when positioned on the stem side. 
Such slurs are now positioned by default more like stem-side slurs between a pair 
of quarter notes (crotchets) or half notes (minims). 

Slurs and articulations of duration. A new option Position of staccato, 
staccatissimo and tenuto relative to slurs has been added to the Slurs section 
of the Articulations page of Engraving Options, allowing you to specify whether 
articulations of duration should be positioned inside or outside slur endpoints. It is 
also possible to override this on a per note basis: activate the new Inside slur 
endpoint property in the Articulations group of the Properties panel. 

Default slur design. The default engraving options for slurs have been subtly 
adjusted, to produce slightly thinner slurs with slightly less pronounced shoulders. 

Stems O 

Hairpins crossing stems. A new Erase background behind stems with erasure 
of width n spaces option has been added to the Stems section of the Notes 
page of Engraving Options. When activated, this causes hairpins that cross stems 
to be split to either side, providing a little daylight between the nearly perpendicular 
lines of the hairpin and the stem. 

Text 

Show text in one layout only. You may need a textual instruction to appear only in 
the performer’s part and not in the conductor’s score. This can now be achieved by 
selecting a text item and activating the new Hide property in the Text group in the 
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Properties panel. The text item will be hidden in the current layout, but will remain 
visible in all other layouts. 

Clef tokens. To show the common G clef, F clef and C clef symbols in text items, 
you can now use the tokens {@gClef@}, {@fClef@} and {@cClef@}, which can 
also be inserted using the right-click menu when editing text, from the Music 
Symbols submenu. 

Time signatures O 

Ties crossing time signatures. A new Erase background behind time signature 
inside staff with erasure of width n spaces option has been added to the 
Design section of the Time Signatures page of Engraving Options. When 
activated, this causes ties that cross a time signature to be split to either side, so 
that the curvature of the tie does not occlude the time signature digits. 

Tuplets 

Popover syntax. You can now use a space instead of a colon to separate the two 
sides of the ratio in the tuplet popover if you choose; this may be useful if the colon 
is awkward to type on your keyboard, which it is in some languages. 

User interface 

What’s New guided tour. When you run Dorico 3.5 for the first time, if Dorico 
detects that you have updated from a previous version, it will show you a brief 
guided tour the first time you visit Setup, Write, Engrave and Play modes to 
introduce you to a few of the new features and improvements in this version of 
Dorico. You can review the guided tour for any mode again in the future by 
choosing Help ▶ What’s New Tour. 

Options dialogs. All five of Dorico’s main options dialogs – Layout Options, 
Notation Options, Engraving Options, Playback Options, and Note Input Options, 
as well as Preferences – now support filtering and search. 

Each dialog has a filter edit box in its top left-hand corner. You can move the focus 
to the filter box by typing typing Ctrl+L (Windows) or Command-L (Mac). 
Whatever you type into the filter will instantly narrow down the list of pages to only 
those pages whose name, or the name of one of its sections, matches. This allows 
you to quickly find the page or section you are looking for, and is especially useful 
in Engraving Options, which has more than 50 pages. 

Having found the page you are looking for, you can hit Tab to move the focus away 
from the filter edit box, and then search within the page by typing Ctrl+F 
(Windows) or Command-F (Mac) to show a search bar at the top of the dialog, 
into which you can type your search term. Dorico reports the number of matches 
and instantly navigates to the first one. Navigate to the next result by typing Ctrl+G 
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(Windows) or Command-G (Mac), or to the previous result with Ctrl+Shift+G 
(Windows) or Shift-Command-G (Mac). Each result is highlighted by changing 
the background color of the text. To close the search bar, simply type Esc. 

If you want to change the key commands used for searching within options dialogs, 
you can edit them on the Key Commands page of Preferences, selecting the 
Options Dialogs category in the table of commands. 

Background colors. New options have been added to the General page of 
Preferences, allowing you to customize the color of the page background for full 
score, part and custom score layouts, and to customize the background gradient in 
Write mode and Engrave mode. 

 

Choose from the Preset menu for a variety of interestingly named gradients, taken 
from the WebGradients collection by designer Dima Braven, or define your own. 
Click any of the swatches to show the color picker and choose a new color, or 
click the reset arrow to reset that color back to its factory default. 

If you prefer to use a single color rather than a gradient for your background, 
activate Single Color, which leaves only the Stop 1 line edit and swatch enabled, 
and uses the color defined there as the entire background. 

Library editors. A number of dialogs in the Engrave menu (Paragraph Styles, 
Character Styles, Playing Techniques, Notehead Sets, Music Symbols, Chord 
Diagrams, the Lines editors, and so on) allow you to save selected items as 
defaults for use in future projects by clicking the star icon (  ) in the action bar. To 
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make it clearer which items have already been saved as defaults, the star will show 
as solid (  ) for saved items. To remove a saved item from the defaults, simply 
click the star icon again: it will be shown as an outline once more. 

Moving the view. A number of improvements have been made to how Dorico 
moves the view in response to changes in the selection or other edits: 

§ When navigating left and right in either galley view or page view, if the 
selected item is a long way out of view, Dorico now always moves the view 
sufficiently far to bring the item into view. 

§ When navigating in galley view, if the current selection is in a different flow 
to that which is currently in view, Dorico now always moves the view to 
bring the selection in the other flow into view. 

§ If any part of the item that is selected is in view, even if it is very close to the 
edge of the screen, Dorico will no longer move the view; previously it would 
move the view if the selection was in view but close to the edge. 

§ When making a large selection that spans multiple pages, for example 
when choosing Edit ▶ Select to End of Flow, if any part of the resulting 
selection is in view, Dorico will no longer move the view at all. 

§ When making a selection that spans a page break, for example by 
repeating the contents of multiple bars of music, Dorico now always moves 
the view to bring some part of the selection into view; previously Dorico 
would not bring the selection into view if the selection extended beyond the 
end of the current page. 

§ When View ▶ Pages ▶ Single Pages Vertically or Spreads Vertically is 
chosen, moving the view vertically with Page Up/Page Down now works 
reliably. 

Furthermore, the width of background that Dorico will allow to the left of the first 
page and to the right of the last page has been reduced, so that when scrolling the 
music left or right to its most extreme position, the edge of the page is kept close 
to the edge of the view. 

Navigating in Write mode. When navigating left or right in Write mode, if a slur is 
selected and there are no further slurs in the direction of navigation, Dorico will 
now hop the selection to the next note or rest after or before the slur as 
appropriate. This allows you to press → to navigate to the next note after inputting 
a slur, provided you have not yet input any more slurs after that point. 

When a whole chord is selected in Write mode, pressing ↓ will leave the top note 
of the chord selected, while pressing ↑ will leave the bottom note of the chord 
selected. This makes it easy to select an individual note in a chord in order to 
modify its pitch. 
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Note input toolbox. With the addition of pitch before duration input, the note 
input toolbox in Write mode has been reorganized. The four tools that are 
always enabled (Select, Pitch Before Duration, Chord Input, Insert) are now 
shown at the top of the panel. The remaining eight tools in the toolbox, and 
the note duration, accidental and articulation buttons in the notes panel, are 
now only enabled if activating them would make sense given the current 
state (for example, whether the caret is visible, whether there is a selection, 
whether mouse input is enabled). 

Adding bars. If you attempt to add bars using the Shift+B popover before 
adding a time signature, you will be prompted to either add a time signature 
or add time using syntax like +12q instead. Similarly, if you attempt to add 
bars using the Insert Bars button in the Bars and Barlines panel before a 
time signature has been added, you will likewise be prompted to add a time 
signature. 

Key commands. It is now possible to assign key commands to the following 
functions, in the following categories in the Key Commands page of Preferences: 

§ Note Input ▶ Disable Mouse Input, otherwise known as the Select tool in 
the note input toolbox. 

§ Edit ▶ Force Centered Stem and Reset Centered Stem. 
§ Edit ▶ Notehead Set now presents a list of the notehead sets defined in 

the factory library and those that you have saved as defaults for newly-
created projects. 

Measurement spin boxes. Numeric controls with up and down paddles to 
increment or decrement the shown value are called spin boxes, and the spin boxes 
Dorico uses to show measurements in the Properties panel and the various options 
dialogs, typically in spaces, now allow you to perform simple arithmetical 
operations on the value. For example: 

§ To add 2 to the current value, enter +=2 into the spin box. 
§ To subtract 3.5 from the current value, enter -=3.5 into the spin box. 
§ To multiply the current value by 1.5, enter *1.5 into the spin box. 
§ To divide the current value by 2, enter /2 into the spin box. 

The behavior of the up and down paddles has also been modified, and clicking the 
paddles with one or more modifier keys depressed now increments or decrements 
the value by the following amounts: 

§ Click with no modifier key: 1/8 space 
§ Click with Ctrl+Shift (Windows) or Shift-Command (Mac): 1/32 space 
§ Click with Shift: 1/2 space 
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§ Click with Ctrl: 1 space 

Instant print preview. If you want to see your music exactly as it will be printed or 
exported to graphics, instead of switching to Print mode, you can now simply hold 
down the key immediately to the left of Z – \ (backslash, on Windows) or ` 
(backtick, on Mac) – to hide all non-printing items, including page margins, frame 
outlines, signposts, system track, bar numbers, voice colors, notes out of range, 
and so on. While the key is depressed, all printing items are shown in the color 
they will actually be printed (typically black, of course), and all non-printing items 
will be hidden. As soon as you release the key, all non-printing items that were 
visible are restored to view. 

Size and position of dialogs. Dorico now keeps track of the size and position of all 
of its dialogs during a single application session, and will restore all dialogs to the 
last-used position when they are shown again. These remembered sizes and 
permissions do not persist when you quit and restart the application. 

Diagnostic reports. When you choose Help ▶ Create Diagnostic Report to create 
an archive of logs for submitting to technical support or the forum, you will now see 
a message telling you where the archive has been created, and when you confirm 
that message, an Explorer (Windows) or Finder (Mac) window will be opened to 
that folder. The archive itself is always named Dorico Diagnostics.zip. 

Performance 

Projects with many flows. Opening a layout in a project with many flows is now 
faster, because Dorico now uses multiple threads to process each flow. 

Playing techniques. Adding a new playing technique to the project is now 
considerably faster than before. 
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Issues resolved 
Component Issue 

Arpeggio signs 
When using the Place items with the mouse preference, clicking on a note in a down-stem voice to 
create arpeggio sign (or a vertical line) now works as expected. 

Articulations 
When using Petaluma and allowing accent articulations to appear inside the staff, accents are now 
correctly positioned one whole space away from the outermost notehead, not in the adjacent space. 

Barlines 

If the option to show a double barline before a coda is set, but the option to show a double barline 
before a start repeat barline is not set, the double barline before a coda coinciding with a start repeat 
barline no longer draws incorrectly. 

Beams Editing music in 3/8 no longer sometimes causes secondary beam groups to change unexpectedly. 

Beams 
Setting Split secondary beam on a note no longer influences the automatic calculation of secondary 
beam groupings, so manually setting a secondary beam break will not otherwise influence grouping. 

Beams 
Fixed beam corners in cases where a partial beam occurs at the beginning or end of a wider beam 
group on an inner beam line further out. 

Beams 
The stem direction calculation for beams with odd numbers of notes and an equal number both above 
and below the staff mid-line now correctly accounts for the side with notes furthest from the mid-line. 

Beams 
When setting single-note tremolos using the panel in Write mode, it no longer causes manual beam 
breaks to be removed. 

Brackets and braces 
In the various orchestral templates, the option Bracketed groups with only one instrument is now 
set to Use bracket by default. 

Brackets and braces Dorico will now correctly group staff labels for an uncondensed staff adjacent to a condensed staff. 

Chord diagrams 
When ordering alternative chord shapes for a particular chord, Dorico no longer prefers shapes that 
include barres above those that do not. 

Chord diagrams 
Changing the tuning for chord diagrams no longer sometimes causes existing chord diagrams in the 
flow to draw as empty grids. 

Chord symbols 
Under some circumstances, Dorico could crash when attempting to add an imported graphic to a 
chord symbol; this problem is now fixed. 

Chord symbols 
Under some circumstances, moving a chord symbol in Engrave mode could cause items elsewhere to 
move unexpectedly. This problem has now been fixed. 

Chord symbols 
The Appearance of major triads option for chord symbols now only applies for simple triads; for 
chord symbols with higher intervals and alterations, the option has no effect. 

Clef Various problems with clef changes in divisi unison passages have been fixed. 

Clefs Typing f3 into the Shift+C popover now creates an F clef on the middle line of the staff, as it should. 

Clefs 
Dorico no longer shows a redundant clef at an instrument change if the clef for the new instrument is 
the same in the transposed part layout but different in the concert score layout. 
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Component Issue 

Comments 
Dorico will no longer crash when attempting to generate initials for the comment author from a UTF-32 
username. 

Comments Selecting a comment in the Comments panel now more reliably brings the comment into view. 

Dynamics 
Under some circumstances, moving a dynamic in Engrave mode could cause items elsewhere to move 
unexpectedly. This problem has now been fixed. 

Dynamics 
Increasing or decreasing the intensity of an immediate dynamic hidden by way of Hide dynamic 
intensity now updates the text of the signpost immediately. 

Dynamics 
A messa di voce hairpin that stops at the barline no longer has a larger than specified gap between the 
two opposing hairpin segments. 

Filters 
When using the Edit ▶ Filter ▶ Note in Chords filters, if a chord contains an exact unison, only one of 
the unison noteheads will now be selected. 

Grace notes 
Selecting multiple grace notes at the same position and hitting T to tie them to the following rhythmic 
note now correctly ties all the selected grace notes, rather than only the top one. 

Guitar notation 
The horizontal position of the right-hand of a guitar bend starting on a grace note and ending on a 
rhythmic note has been improved. 

Guitar notation 
Typing Ctrl+left/right to navigate to the start of the next or previous bar in tablature no longer causes a 
crash. 

Guitar notation 
Clicking Export Tuning in the Edit Strings and Tunings dialog no longer causes the file chooser to 
appear twice in succession. 

Harp pedalling 
When copying and pasting a harp pedal change to the same position as an existing change, the 
pasted harp pedal change will overwrite the existing one, even if it is attached to the other staff. 

Instrument types 
The transposition of the handbells instrument has been corrected. Handbells sound one octave higher 
than written. 

Instrument types The banjo and tenor banjo instruments now have the correct octave transposition. 

Key signatures 
When editing a custom key signature, it is no longer possible to attempt to add more accidentals to the 
key signature when the maximum number of accidentals has already been reached. 

Key signatures 
A problem whereby cancelling the changes made in the Edit Key Signature dialog would nevertheless 
persist despite have been cancelled has been resolved. 

Key signatures The input string for an open or atonal key signature is now parsed case-insensitively. 

Lines Note-attached horizontal lines are now correctly duplicated when duplicating a flow. 

Lines 
Improvements to the editing horizontal lines whose ends are note-attached to prevent their duration 
from becoming negative when moving their start position. 

Lines 
When importing one or more flows from another project, horizontal and vertical lines from the source 
flow are now correctly imported. 
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Component Issue 

Localization 
Dorico’s user interface is now always shown in the Noto Sans JP font family, instead of allowing the 
operating system to choose the font automatically. 

Lyrics 
Adjusting the vertical position of a line of lyrics on a system that also contains material cued from 
another instrument now works correctly. 

Lyrics 
It is now possible to nudge multiple lyrics with the same line number but belonging to different voices 
vertically in Engrave mode. 

Lyrics Soft or discretionary hyphens are now filtered out from lyrics that are pasted into Dorico. 

Lyrics 
Moving a selected lyric with Alt+←/→, or pasting it, to a position that contains lyrics in other lines no 
longer causes all other lyrics at that position to be overwritten. 

Lyrics 
Lyric verse numbers are now correctly aligned with the line of lyrics to which they correspond, even if 
the verse numbers are drawn at a smaller size. 

Multi-bar rests 
When a multi-bar rest starts with a special barline, the width and positioning of the H-bar now takes 
the width of the special barline into account. 

MusicXML export 
Players are no longer incorrectly omitted from exported MusicXML files if the current layout does not 
included all players. 

MusicXML export 
When a voice ends in the middle of a tuplet, the resulting exported MusicXML now includes the 
necessary hidden rests to ensure the output is valid. 

MusicXML import 
Rehearsal marks such as F and P in MusicXML files are no longer incorrectly also imported as 
dynamics. 

MusicXML import 
Opening a MusicXML file that reports a validation error when another project is already open no longer 
incorrectly causes the other project window to receive the focus after you dismiss the validation error. 

Note input 
When copying and pasting a selection made from the system track, Dorico no longer pastes break 
events that do not apply to the current layout. 

Note input 
Copying and pasting a playing technique or text item to the same rhythmic position as an existing item 
of the same type no longer overwrites the existing item. 

Notes The position of rhythm dots on long and maxima notes on staff lines has been corrected. 

Page layout 
When using Make into System on a range that starts with a frame break, if the initial frame break has 
the Wait for next frame break property set, that property value is now correctly retained. 

Page layout 
It is once again possible to adjust the distance between the individual lines of a percussion grid when 
editing staff spacing in Engrave mode. 

Percussion 
When exporting a percussion kit, all dependent notehead sets and playing techniques are now 
correctly included. 

Percussion 
MIDI note 32 in the Yamaha XG percussion map (used in the default HSSE playback configurations) 
is now correctly defined as stick click (two drum sticks clicking together), not cross stick. 

Percussion Mark tree now plays back with a more suitable sound in the default HSSE playback configurations. 
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Component Issue 

Percussion 
When moving a note up or down in a percussion kit using either the five-line staff or grid presentation, 
Dorico no longer loses track of any tuplets that may be active. 

Percussion 
Under rare circumstances, adding a new percussion instrument to an existing percussion kit could 
cause Dorico to crash; this has now been fixed. 

Performance 
Under rare circumstances, it could be impossible to start note input by double-clicking in projects with 
many flows using flow headings; this has now been fixed. 

Play mode 
Dragging and dropping MIDI data from Cubase into Play mode into a Dorico project with no time 
signature now works correctly 

Playback 
If Dorico needs to transpose by one or more octaves to play a playing technique correctly, it now 
checks the octave of the requested combination, not only the Natural playing technique. 

Playback 
The Suspend audio engine when in background preference has been removed, since it caused 
more problems than it solved. 

Playback 
Under certain circumstances, slurs starting and ending within a run of grace notes would not cause the 
legato playback playing technique to be removed at the end of the slur; this has now been fixed. 

Playback The playback of glissandos on notes whose start positions are affected by swing has been corrected. 

Playback 
Under certain circumstances, removing a tie from a note with a single-stem tremolo would not cause 
playback to reflect the tremolo until the project was reopened; this problem has now been fixed. 

Playback Events in the dynamics lane no longer prevent playback of automatic dynamics following a repeat. 

Playback Messa di voce and sfzorzando dynamics now play correctly following a repeat. 

Playing techniques 
If you use an imported graphic in a playing technique appearance, editing that playing technique a 
second time will no longer lose track of the imported graphic. 

Repeat markers The vertical positioning of repeat count text at the start of successive systems has been improved. 

Selections 
With a single note in a chord selected, Select More now once again selects all of the remaining notes 
in the chord. 

Selections 
Breath marks are now included in block selections, i.e. when you click in a blank spot in a bar to select 
its contents. 

Setup mode 
The order of the instruments in the Big Band brass ensemble has been corrected, with saxophones 
coming before trumpets and trombones. 

Slurs 
The Maximum angle for slurs option now applies both to slurs that slant upwards and downwards; 
previously it only applied for upwards-slanting slurs, resulting in asymmetry in some situations. 

Tablature 
Lyric hyphens and extender lines are no longer incorrectly shown on tablature if lyrics are shown on the 
associated regular staff. 

Tempo 
It is now possible to specify a maximum of four rhythm dots for a metronome mark in the Shift+T 
popover. 
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Component Issue 

Text The baseline for the Regular and Italic weights of Academico was inconsistent; this is now fixed. 

Time signatures 
If you replace a barline in the middle of an aggregate time signature, the overridden barline will now be 
correctly preserved when reopening the project. 

Time signatures 
Changing the Separator property for an interchangeable time signature from - to = now immediately 
updates the score. 

Tonality systems 
When exporting a tonality system, Dorico now includes any required custom font styles and imported 
graphics to ensure custom accidentals and key signatures appear correctly when imported elsewhere. 

User interface 
When you use a pinch gesture to zoom in or out in a project window with a vertical or horizontal split, 
Dorico now zooms the view under the mouse pointer, rather than the one that is currently in focus. 

User interface 
When switching layout in the current tab and switching to a layout that has previously been open in the 
current session, the last viewport position of the layout is now correctly restored. 

User interface 
When applying changes in the Project Info dialog, Dorico no longer sometimes incorrectly loses the 
selection in the list of flows. 

User interface 
Under some circumstances, saving the project immediately after undoing an action could cause the 
view to jump when the save completes; this problem has now been fixed. 

User interface 
The right-hand options panel in Print mode is now wider when running Dorico in French, so that the 
translated text fits within the panel without scrolling. 

User interface The Edit ▶ Chord Diagrams submenu is now also included in the right-click context menu. 

User interface 
When a modeless dialog, such as Project Info or any of the options dialogs, is open when the user 
changes the name of the project using Save As, the name shown in the dialog title bar now updates. 

User interface 
Typing Tab after typing a value into a spin box to move focus to the next column in the Actions table in 
Play ▶ Expression Maps now correctly remembers the value you typed. 

User interface 
The Custom spacing ratio control in the Note Spacing Change dialog now behaves the same way 
as the corresponding control on the Note Spacing page of Layout Options. 
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Known issues and solutions 

Frequently asked questions 
Answers to frequently asked questions about Dorico can be found online in the 
Dorico forum. 

Knowledge base 
For the latest information about issues and solutions you may encounter when 
running Dorico, please consult the Knowledge Base. 

Entering the eLicenser Activation Code (Mac only) 
When you first run Dorico and are prompted to enter your Activation Code, you 
may find that after you have successfully activated your Soft-eLicenser, you must 
quit and restart Dorico for the application to detect that it is fully licensed. 

Key commands to transpose notes by an octave (Windows only) 
The Intel Graphics Adaptor drivers used by many Windows computers define a 
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut 
Ctrl+Alt+up/down/left/right arrows. 

Ctrl+Alt+up/down option conflicts with the key commands in Dorico note input for 
transposing notes by an octave. 

For information about how to disable the default Intel Graphics Adaptor key 
command, consult the Knowledge Base. 

https://helpcenter.steinberg.de/hc
https://helpcenter.steinberg.de/hc
https://www.steinberg.net/forums/viewtopic.php?f=246&t=104450



